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ABSTRACT 

 

In 2010, a new off-the-shelf software for Computer Vision Photogrammetry, 

Agisoft PhotoScan, became available to nautical archeologists, and this technology has 

since become a popular method for recording underwater shipwreck sites. Today (2015), 

there are still active discussions regarding the accuracy and usage of Computer Vision 

Photogrammetry in the discipline of nautical archaeology. The author believes that 

creating a 1:1 scale constrained photogrammetric model of a submerged shipwreck site 

is not difficult as long as archaeologists first establish a local coordinate system of the 

site.  After creation of a 1:1 scale constrained photogrammetric model, any 

measurements of the site can be obtained from the created 3D model and its digital data. 

This means that archaeologists never need to revisit the archaeological site to take 

additional measurements. Thus, Computer Vision Photogrammetry can substantially 

reduce archaeologists’ working time in water, and maximize quantity and quality of the 

data acquired. 

Furthermore, the author believes that the acquired photogrammetric data can be 

utilized in traditional ship reconstruction and other general studies of shipwrecks. With 

this idea, the author composed a new methodology that fuses Computer Vision 

Photogrammetry and other digital tools into traditional research methods of nautical 

archaeology. Using this method, archaeologists can create 3D models that accurately 

represent submerged cultural heritage sites, and these can be used as representative 

archaeological data. These types of representative data include (but are not limited to) 
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site plans, technical artifact or timber drawings, shipwreck section profiles, 

georeferenced archaeological information databases, site-monitoring systems, digital 

hull fragment models and many other types of usable and practical 3D models. In this 

dissertation, the author explains his methodology and related new ideas. 
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CHAPTER I 

INTRODUCTION 

 

Introduction: Objective of This Dissertation 

In recent years, applications of Computer Vision Photogrammetry have become 

popular in nautical archaeology.  This technology has been repeatedly tested in 

archaeological surveys and excavations, both in dry and submerged environments, yet 

there are still active discussions about the efficiency and accuracy of photogrammetry 

models. With a team from the Nautical Archaeology Program in the Anthropology and 

analyze underwater shipwreck sites with off-the-shelf software. The methodology 

utilized a technique called Computer Vision Photogrammetry (Fig. 1-1).  As a 

modification of traditional photogrammetry, Computer Vision Photogrammetry does not 

require the traditional two-camera equipment set-up. Instead, it uses sets of independent 

images with a certain amount of overlap (Agisoft LLC, 2014). This methodology 

produces reliable archaeological data based on 1:1 scale-constrained photogrammetry 

models. Examples of data that can be produced include 2D site plans, artifact and timber 

drawings, section profiles of shipwreck sites and reconstructed hull lines, georeferenced 

archaeological information databases, point based site-monitoring systems, digital 

format fragment models for hull analysis, and various styles of 3D models of 

shipwrecks, all in an easily shared format.  
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Figure 1-1. The workflow of the proposed methodology. This methodology follows the conventional 

research methods of nautical archaeology developed by J. Richard Steffy, the first director of the Ship 

Reconstruction Laboratory (ShipLab) at Texas A&M University, and was developed by the author and his 
colleagues in the ShipLab. For those reasons, the author named this methodology the "ShipLab 

methodology". (Image: Yamafune) 

 



 

3 

 

This dissertation follows the methodological workflow developed by the author 

and his colleagues, Dr. Rodrigo Torres and Dr. Luis Filipe Viera de Castro, and proposes 

a methodology to fuse new technologies with conventional nautical archaeology 

research methods. This dissertation is composed of six chapters, with Chapter I 

introducing the topic.  Chapter II reviews techniques and methods employed to collect 

data used to produce accurate 3D photogrammetric models and to capture other 

important archaeological information to understand the shipwreck site.  Chapter III 

discusses methods used to process data in order to create accurate 1:1 scale-constrained 

photogrammetric models, and to produce organized databases, accurate 2D site plans 

and artifact drawings, section profiles of shipwreck sites, and georeferenced high 

resolution photo mosaics.  Chapter IV presents a method for analyzing shipwreck sites 

using generated output to better understand the ship; this chapter is similar to 

conventional research applied by nautical archaeologists, but it includes additional new 

methods proposed to facilitate archaeological research. These proposed analysis methods 

are the Interactive Fragment Model for hull analysis, and a cloud-based site monitoring 

method for site analysis.  Chapter V discusses methods for sharing research outcomes 

with the general public, and Chapter VI concludes the dissertation by reviewing potential 

uses of the proposed methodology.  

The workflow proposed in this dissertation was designed to combine Computer 

Vision Photogrammetry and traditional archaeological excavation methods. Although 

photogrammetric models are primarily used for visualization purposes, the author 

proposes that they can be used as sources of accurate archaeological data, and support 
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traditional archaeological work. The major advantage of Computer Vision 

Photogrammetry in underwater excavations is that it simplifies the data acquisition 

procedure, thus reducing the recording time. The underwater recording process is 

reduced to the establishment of a basic reference grid, and the acquisition of high quality 

photos with a certain amount of overlap. Photogrammetry minimizes the underwater 

recording time and maximizes the quality of the data acquired. Furthermore, this process 

produces extremely versatile digital datasets, which can be migrated and converted into 

many formats, then stored, organized and processed in order to analyze site formation 

processes and reconstruct the archaeological remains. Application in the field of the 

methods proposed in this dissertation will save time, save money, and produce accurate, 

reproducible, and sharable datasets for analyzed wreck sites. 

 

Current Status of Study 

Archaeologists destroy the sites they excavate, which makes recording and 

publishing two serious responsibilities. From its development in the 19th century, 

photography has been one of the archaeologist’s best companions. Photogrammetry – 

the art and science of deriving accurate 3D metric and descriptive object information 

from multiple images (Al-Ruzouq, 2012) – was originally developed as a technology to 

provide topographic information for map making (Burtch, 2008; Van Damme, 2015; 

Konecny, 2003). During the 20th century it slowly became a useful tool for 

archaeologists, but it was not until the 1960s that is was used underwater, when Dr. 

George Bass experimented with photogrammetry for the recording of the Byzantine 
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shipwreck Yassiada 2 (Drap, 2012). Dr. Bass used one camera mounted along a rail to 

shoot pairs of photogrammetric images, and later mounted two synchronized cameras on 

the University of Pennsylvania submarine Ashera (Bass and Van Doorninck, 1971; Bass 

and Rosencrantz, 1972; Rosencrantz, 1975). Starting in the early 1960s as a discipline 

informed by scientific principles, nautical archaeology developed quickly, and 

underwater photography was used as a basic tool from the beginning (Baker and Green, 

1976; Green, 2004). Nautical archaeology aims to reconstruct ship shapes and structures, 

which are more often than not complex surfaces, defined by complex curves, sometimes 

conceived using combinations of simple curves whose reconstruction is relevant for 

understanding the history of technology, science, and thought.  

Underwater archaeology is often constrained by depth, current, temperature, and 

visibility, and demands continuous economy of the archaeologist’s time underwater. 

These factors have fueled a constant search for increased speed and accuracy. The 

development of computers in the 1980s created opportunities for the development of 

iterative trigonometric software to triangulate tridimensional points; such software could 

be applied to underwater photography (Cancian et al., 2002; Drap, 2012). In the 

beginning of the 21st century, surveying methods using photography underwent rapid 

development, and photogrammetry to calculate coordinates of assigned points using an 

accurately calibrated camera made its appearance in underwater archaeology (Green, 

Matthews, and Turanli, 2002). Off-the-shelf software using digital images, such as 

PhotoModeler, was tested and discussed its accuracy in comparison with triangulation 



 

6 

 

software such as Site Surveyor (Green, Matthews, and Turanli, 2002: Holt 2003: Green 

and Gainsford 2003).  

In the last five years, a new software package using Computer Vision 

Photogrammetry (also known as multi-image photogrammetry, or close-range 

photogrammetry) became available to archaeologists (Skarlatos and Rova, 2010; Doneus 

et al., 2011; Drap, 2012; Diamanti, Georgopoulos, and Vlachaki, 2011; Zhukvsky, 

Kuznetsov, and Olkhovsky, 2013; Henderson, Pizarro, Johnson-Roberson, and Mahon, 

2013; McCarthy and Benjamin, 2014). Under the commercial designation PhotoScan, 

this package does not require calibration of the cameras.  

Using Computer Vision Photogrammetry, PhotoScan creates meshes, or 

geometry of 3D models, using pixel information from digital images, producing data 

files similar to those obtained from tridimensional laser scanners. The author sought to 

use this software in combination with other digital tools to record and reconstruct ship 

shapes and structures, as well as to produce animations, drawings, and orthogonal 

projections aiming at divulging and explaining the projects as they unfold. 

The main goal of this methodology is to extract archaeological information from 

tridimensional models. Once accurate 1:1 scale tridimensional models are created, 

archaeologists can extract data from the digital models without having to revisit the 

actual sites. Care was taken to refine the data acquisition methodology in order to 

expand its application to non-intrusive and rescue archaeology projects. 
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Methodology 

In this dissertation the author will discuss methodology for acquiring data, 

processing data, and analyzing data. The core of the recording method is Computer 

Vision Photogrammetry; the goal of this methodology is to understand and reconstruct 

the ship during its operational career. The author originally designed the methodology as 

a guideline for archaeologists to record and analyze underwater shipwreck sites. The 

dissertation also discusses different methods used to collect data and to evaluate the 

accuracy of acquired data. In the main discussion, Chapter IV, the author presents 

methods for reconstructing the original ships based on data extracted from Computer 

Vision photogrammetric models.  

This proposed methodology is not blinding flash of an original idea; instead, it is 

a combination of conventional archaeological recording and research methods with 

newly available technologies. In other words, archaeologists still need the same 

information to understand shipwreck sites; however, this methodology provides the 

required information faster and more accurately. Consequently, nautical archaeologists 

can proceed and complete their excavations and research more efficiently using this 

proposed methodology, while concurrently preserving tridimensional data of underwater 

shipwreck sites for subsequent generations of researchers.        
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CHAPTER II 

 DATA COLLECTION 

 

Photography 

The first step in creating accurate tridimensional models from Computer Vision 

photogrammetry is to take good photos. Choosing the right camera and accessory 

equipment is essential to ensure that clear and properly colored images are captured. 

Although there is a range of acceptable solutions from which archaeologists can choose, 

the best results depend heavily on the equipment. (Zhukovsky, Kuznetsov, and 

Olkhovsky, 2013) discussed constraints in underwater photography, which include 

optical distortion and optical noise.  

Optical distortion is generated when light passes through media of different 

densities, such as water and then the air in the underwater camera housing. Refraction 

causes distortion in images; it also narrows the coverage area of a single photo (Gietler, 

2009). To minimize optical distortion, the best possible solution is a hemispheric dome-

port (Zhukovsky, Kuznetsov, and Olkhovsky, 2013). The hemispherical shape of the 

dome allows light to enter the lens thought the underwater housing perpendicularly; 

therefore, it can minimize the refraction caused by the different densities of the water 

and air. 

Optical noise can be minimized by the use of wider-angle lenses (focal length of 

11mm – 18mm). Cameras with wider-angle lenses can get closer to the subject while 

keeping a wider coverage area. Simply put, an 11 mm focal length lens can capture twice 
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the area of a 22 mm focal length lens (Fig. 2-1). In other words, a camera with an 11 mm 

lens can be used at half the distance from the object as the same camera with a 22 mm 

lens, while covering the same area. This is an important factor in capturing crisp images 

for successful photogrammetry because underwater visibility introduces limitations for 

underwater photography and photogrammetry.  Using a wide-angle lens minimizes the 

capture of optical noise, while still covering a large area, thus minimizing the number of 

photos required for effective Computer Vision Photogrammetry.  

 

 

 
Figure 2-1. Difference of coverage areas based on focal lengths (From outside: 11 mm, 16 mm, 18 mm, 24 

mm, 35 mm). (Image: Yamafune) 
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Another factor that affects the size of the coverage area and quality of the images 

is the sensor size of the camera (Crisp, 2013). Larger sensors can collect more pixel data 

(light information) and can cover a wider area in the same way as wider-angle lenses.  

Technically speaking, underwater photogrammetry can be done by any type of 

camera that can be operated at the desired depth in water; nonetheless, more 

professional, or expensive, cameras tend to have larger sensor sizes and more precise 

exposure-control over the photos (Fig. 2-2). This is one of the main reasons that Digital 

Single Lens Reflex cameras (DSLRs) are recommended for underwater photography and 

photogrammetry.  

 

 

 
Figure 2-2. Difference of coverage areas based on sensor sizes (From outside: Full Frame (Professional 

DSLRs), APS-C (Advanced Amateur DSLRs), 1-inch (Higher-End Compacts), and 1/1.7-inch (Compact 

Cameras). (Image: Yamafune) 
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Most manufactured DSLRs are categorized as either professional level or 

advanced-amateur level. As a result, DSLRs are more expensive than compact cameras.  

Another benefit of DSLRs is that they have greater options for lens types and accessory 

equipment, including underwater camera housings and strobe lights. Most manufactured 

compact cameras tend to come equipped with fixed-lenses which are not 

interchangeable, and the minimum focal length of those fixed lens are, in most cases, 

around 24 mm.  Thus, DSLR cameras with larger sensor sizes and wider lens options are 

recommended for use in underwater photogrammetry.  

Table 2-1 displays recently manufactured camera models of Canon, Nikon, and 

Sony, and their approximate retail sales price as indicated by their official company web 

pages (as of August 2015).  The models in the table were selected based on availability 

of compatible underwater housings; in other words, only camera types that have 

available underwater housings manufactured by well-known companies (as of August 

2015) were listed on Table 2-1. The underwater housing companies selected by the 

author were Ikelite, Equinox Underwater Housings, Nauticam, Sea and Sea, and 

Aquatica. 

 

 

Table 2-1. Major camera types that have available underwater housings 
 Full Frame 

(36 x 24mm) 

APS-C 

(22.3 x 14.9mm) Canon 

(23.6 x 15.6mm) Others 

1-in  

(13.8 x 8.8mm) 

1/1.7-in 

(7.60 x 5.50mm) 

Canon 1DX 

($5.999.00) 

7D Mark II 

($1799.00) 

G7 X 

($699.99) 

G16 

($499.99) 

5D mark III 

($3,099.00) 

6Da 

($1,499.00) 

 S120 

($449.99) 
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Table 2-1 Continued 

 

 

 6D 

($1.799.00) 

70D 

($1,199.00) 

 S110 

($299.99) 

5DSR 

($3,899.00) 

60D  

($899.99) 

 

 5DS 

($3,699.00) 

Rebel T5i 

($849.00) 

  

 Rebel SL1 

($699.99) 

Rebel T3i 

($599.99) 

Rebel T5 

($549.99) 

Rebel T3 

($449.99) 

Rebel T6s 

($1,199.00) 

*Rebel T6i 

($899.00) 

Nikon D4 

($5,999.95) 

D7100 

($999.95) 

 P7800 

($549.95) 

D4S 

($5.999.95) 

D7000 

($999.95) 

P340 

($349.95) 

D810 

($2,999.95) 

D5300 

($699.95) 

D750 

($2,299.95) 

D5200 

($549.95) 

D610 

($1,499.95) 

D3300 

($449.95) 

D810 

($3,799.95) 

D3200 

($449.95) 

 D5500 

($899.95) 

Sony A7R 

($2,099.00) 

A6000 

($549.00) 

RX100 III 

($799.99) 

 

A99 

($1.999.00) 

A5000 

($399.00) 

RX 100 

($499.99) 
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Tables 2-2 and 2-3 indicate coverage areas of one photo by each sensor size, 

based on different focal lengths, lens types, and distance from the object.  In short, these 

two tables show sizes of coverage areas based on equipment and circumstance.  For 

instance, when an advanced amateur camera with APS-C sensor size equipped 16 mm 

focal length lens was used from 1.5 m away from the subject, a photo image can cover 

2.20 m horizontally, and 1.47 m vertically.  

 

 

Table 2-2. Approximate coverage area of one photo by a camera with an APS – C 

sensor (23.5 mm x 15.6 mm) 
Focal 

Length 

Subject Distance 

11 mm 
HAV: 93.78 

16 mm 
HAV: 72.59 

18 mm 
HAV: 66.27 

24 mm 
HAV: 52.17 

35 mm 
HVA: 37.12 

0.5 m 1.07 x 0.71 m 0.73 x 0.49 m 0.65 x 0.43 m 0.49 x 0.33 m 0.34 x 0.22 m 

1.0 m  2.14 x 1.42 m 1.47 x 0.98 m 1.31 x 0.87 m 0.98 x 0.65 m 0.64 x 0.45 m 

1.5 m 3.20 x 2.13 m 2.20 x 1.46 m 1.96 x 1.30 m 1.47 x 0.98 m 1.01 x 0.67 m 

2.0 m 4.27 x 2.84 m 2.94 x 1.95 m 2.61 x 1.73 m 1.96 x 1.30 m 1.34 x 0.89 m 

2.5 m 5.34 x 3.55 m 3.64 x 2.44 m 3.26 x 2.17 m 2.45 x 1.63 m 1.68 x 1.11 m 

3.0 m 6.41 x 4.69 m 4.41 x 2.93 m 3.92 x 2.60 m 2.94 x 1.95 m 2.01 x 1.34 m 

 

  

Table 2-3. Approximate coverage area of one photo by a camera with a full-frame 

sensor (35.9 mm x 24 mm) 
Focal 

Length 

Subject Distance 

11 mm 
HAV: 117.00 

16 mm 
HAV: 96.57 

18 mm 
HAV: 89.84 

24 mm 
HAV: 73.59 

35 mm 
HVA: 54.30 

0.5 m 1.63 x 1.09 m 1.12 x 0.75 m 1.00 x 0.67 m 0.75 x 0.50 m 0.51 x 0.34 m 

1.0 m  3.26 x 2.18 m 2.24 x 1.50 m 1.99 x 1.33 m 1.50 x 1.00 m 1.03 x 0.69 m 

1.5 m 4.90 x 3.27 m 3.37 x 2.25 m 2.99 x 2.00 m 2.24 x 1.50 m 1.54 x 1.03 m 

2.0 m 6.53 x 4.36 m 4.49 x 3.00 m 3.99 x 2.67 m 2.99 x 2.00 m 2.05 x 1.37 m 

2.5 m 8.16 x 5.45 m 5.61 x 3.75 m 4.99 x 3.33 m 3.74 x 2.50 m 2.56 x 1.71 m 

3.0 m 9.79 x 6.55 m 6.73 x 4.50 m 5.98 x 4.00 m 4.49 x 3.00 m 3.08 x 2.06 m 
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The creators of Agisoft PhotoScan recommend that two consecutive photos have 

an 80% overlapping area with the forward image, and a 60% overlapping area with the 

adjacent image for successful photogrammetry coverage (Agisoft LLC, 2014). This 80% 

overlap results in each specific location appearing in at least four separate photographs 

for successful photogrammetry coverage.  Based on this recommendation, the values of 

Tables 2-4 and 2-5 display the progression of camera positions from the previous photo 

location to the following one. For instance, when a camera has a full-frame sensor size 

with a 24 mm focal length lens, and photos are taken 3.0 m away from the subject, 

photos are recommended to be taken every 60 cm forward, with 180 cm side overlap.  

 

 

Table 2-4. Approximate frequency of photo taking to keep ideal overlapping by a 

camera with an APS-C sensor (23.5 mm x 15.6 mm) 
Focal 

Length 

Subject Distance 

11 mm 
HAV: 93.78 

16 mm 
HAV: 72.59 

18 mm 
HAV: 66.27 

24 mm 
HAV: 52.17 

35 mm 
HVA: 37.12 

0.5 m Forward: 14 cm 

Side: 43 cm 

Forward: 10 cm 

Side: 29 cm 

Forward: 9 cm 

Side: 26 cm 

Forward: 7 cm 

Side: 20 cm 

Forward: 4 cm 

Side: 14 cm 

1.0 m  Forward: 28 cm 

Side: 86 cm 

Forward: 19 cm 

Side: 59 cm 

Forward: 17 cm 

Side: 52 cm 

Forward: 13 cm 

Side: 39 cm 

Forward: 9 cm 

Side:36 cm 

1.5 m Forward: 43 cm 

Side: 128 cm 

Forward: 29 cm 

Side: 88 cm 

Forward: 26 cm 

Side: 78 cm 

Forward: 20 cm 

Side: 59 cm 

Forward: 13 cm 

Side: 40 cm 

2.0 m Forward: 57 cm 

Side: 171 cm 

Forward: 39 cm  

Side: 118 cm 

Forward: 35 cm 

Side: 104 cm 

Forward: 26 cm 

Side: 78 cm 

Forward: 18 cm 

Side: 54 cm 

2.5 m Forward: 71 cm 

Side: 214 cm 

Forward: 49 cm 

Side: 146 cm 

Forward: 43 cm 

Side: 130 cm 

Forward: 33 cm 

Side: 98 cm 

Forward: 22 cm 

Side: 67 cm 

3.0 m Forward: 94 cm 

Side: 256 cm 

Forward: 59 cm 

Side: 176 cm 

Forward: 52 cm 

Side: 157 cm 

Forward: 39 cm 

Side: 118 cm 

Forward: 27 cm 

Side: 80 cm 

 

 

Table 2-5. Approximate frequency of photo taking to keep ideal overlapping by a 

camera with a full-frame sensor (35.9 mm x 24 mm) 
Focal 

Length 

Subject Distance 

11 mm 
HAV: 117.00 

16 mm 
HAV: 96.57 

18 mm 
HAV: 89.84 

24 mm 
HAV: 73.59 

35 mm 
HVA: 54.30 

0.5 m Forward: 22 cm 

Side: 65 cm 

Forward: 15 cm 

Side: 45 cm 

Forward: 13 cm 

Side: 40 cm 

Forward: 10 cm 

Side: 30 cm 

Forward: 7 cm 

Side: 20 cm 
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Table 2-5 Continued 

 

1.0 m  Forward: 43 cm 

Side: 130 cm 

Forward: 30 cm 

Side: 90 cm 

Forward: 27 cm 

Side: 80 cm 

Forward: 20 cm 

Side: 60 cm 

Forward: 14 cm 

Side:41 cm 

1.5 m Forward: 65 cm 

Side: 196 cm 

Forward: 45 cm 

Side: 135 cm 

Forward: 40 cm 

Side: 120 cm 

Forward: 30 cm 

Side: 90 cm 

Forward: 21 cm 

Side: 62 cm 

2.0 m Forward: 87 cm 

Side: 261 cm 

Forward: 60 cm  

Side: 180 cm 

Forward: 53 cm 

Side: 160 cm 

Forward: 40 cm 

Side: 120 cm 

Forward: 27 cm 

Side: 82 cm 

2.5 m Forward: 109 cm 

Side: 326 cm 

Forward: 75 cm 

Side: 224 cm 

Forward: 67 cm 

Side: 200 cm 

Forward: 50 cm 

Side: 150 cm 

Forward: 34 cm 

Side: 102 cm 

3.0 m Forward: 131 cm 

Side: 392 cm 

Forward: 90 cm 

Side: 269 cm 

Forward: 80 cm 

Side: 239 cm 

Forward: 60 cm 

Side: 180 cm 

Forward: 41 cm 

Side: 123 cm 

 

 

Lastly, Tables 2-6 and 2-7 show the total recommended number of photos 

required to provide proper image overlap (80% forward and 60% side). For example, 

when a camera with an APS-C sensor equipped with an 11 mm focal length lens is 

employed at 1.0 m distance to cover a 5 m x 5 m area, 50 photos are required to cover 

the entire area with the recommended overlap.  

 

 

Table 2-6. Recommended total number of photos to cover a required area by a camera 

with a APS-C sensor 
Focal 

Length 

Subject Distance 

11 mm 
HAV: 93.78 

16 mm 
HAV: 72.59 

18 mm 
HAV: 66.27 

24 mm 
HAV: 52.17 

35 mm 
HVA: 37.12 

0.5 m 10 m2: 1680 

5 m2: 442 

3 m2: 160 

10 m2: 3430 

5 m2: 882 

3 m2: 308 

10 m2: 4290 

5 m2: 1080 

3 m2: 384 

10 m2: 7191 

5 m2: 1820 

3 m2: 656 

10 m2: 17856 

5 m2: 4551 

3 m2: 1606 

1.0 m  10 m2: 442 

5 m2: 112 

3 m2: 36 

10 m2: 918 

5 m2: 225 

3 m2: 84 

10 m2: 1140 

5 m2: 308 

3 m2: 112 

10 m2: 2025 

5 m2: 518 

3 m2: 189 

10 m2: 4252 

5 m2: 1080 

3 m2: 416 

1.5 m 10 m2: 198 

5 m2: 50 

3 m2: 15 

10 m2: 396 

5 m2: 112 

3 m2: 36 

10 m2: 519 

5 m2: 126 

3 m2: 50 

10 m2: 882 

5 m2: 216  

3 m2: 84 

10 m2: 1950 

5 m2: 481 

3 m2: 168 

2.0 m 10 m2: 113 

5 m2: 28 

3 m2: 12 

10 m2: 216 

5 m2: 55 

3 m2: 24 

10 m2: 297 

5 m2: 78 

3 m2: 28 

10 m2: 518 

5 m2: 126 

3 m2: 50 

10 m2: 1081 

5 m2: 260 

3 m2: 105 

2.5 m 10 m2: 79 

5 m2: 15 

3 m2: 6 

10 m2: 152 

5 m2: 36 

3 m2: 15 

10 m2: 198 

5 m2: 50 

3 m2: 15 

10 m2: 319 

5 m2: 84 

3 m2: 32 

10 m2: 704 

5 m2: 168 

3 m2: 60 

3.0 m 10m2: 46 

5m2: 12 

3m2: 4 

10 m2: 105 

5 m2: 28 

3 m2: 12 

10 m2: 126 

5 m2: 32 

3 m2: 12 

10 m2: 216 

5 m2: 55 

3 m2: 24 

10 m2: 468 

5 m2: 119 

3 m2: 50 

 



 

16 

 

Table 2-7. Recommended total number of photos to cover a required area by a camera 

with a full-frame sensor (35.9mm x 24mm) 
Focal 

Length 

Subject Distance 

11 mm 
HAV: 117.00 

16 mm 
HAV: 96.57 

18 mm 
HAV: 89.84 

24 mm 
HAV: 73.59 

35 mm 
HVA: 54.30 

0.5 m 10 m2: 704 

5 m2: 189 

3 m2: 72 

10 m2: 1495 

5 m2: 384 

3 m2: 144 

10 m2: 1950 

5 m2: 481 

3 m2: 168 

10 m2: 3332 

5 m2: 864 

3 m2: 308 

10 m2: 7191 

5 m2: 1820 

3 m2: 656 

1.0 m  10 m2: 198 

5 m2: 50 

3 m2: 15 

10 m2: 384 

5 m2: 105 

3 m2: 32 

10 m2: 468 

5 m2: 119 

3 m2: 50 

10 m2: 864 

5 m2: 207 

3 m2: 78 

10 m2: 1750 

5 m2: 442 

3 m2: 160 

1.5 m 10 m2: 84 

5 m2: 24 

3 m2: 9 

10 m2: 168 

5 m2: 50 

3 m2: 15 

10 m2: 207 

5 m2: 55 

3 m2: 18 

10 m2: 384 

5 m2: 105  

3 m2: 32 

10 m2: 782 

5 m2: 198 

3 m2: 78 

2.0 m 10 m2: 50 

5 m2: 12 

3 m2: 4 

10 m2: 105 

5 m2: 28 

3 m2: 9 

10 m2: 119 

5 m2: 32 

3 m2: 12 

10 m2: 207 

5 m2: 55 

3 m2: 18 

10 m2: 455 

5 m2: 119 

3 m2: 45 

2.5 m 10 m2: 32 

5 m2: 9 

3 m2: 4 

10 m2: 60 

5 m2: 15 

3 m2: 4 

10 m2: 78 

5 m2: 18 

3 m2: 6 

10 m2: 144 

5 m2: 32 

3 m2: 12 

10 m2: 308 

5 m2: 78 

3 m2: 28 

3.0 m 10 m2: 24 

5 m2: 4 

3 m2: 4 

10 m2: 50 

5 m2: 12 

3 m2: 4 

10 m2: 55 

5 m2: 15 

3 m2: 4 

10 m2: 105 

5 m2: 28 

3 m2: 9 

10 m2: 207 

5 m2: 55 

3 m2: 18 

 

 

The tables above can be used as guidelines when choosing cameras and lenses 

based on the unique conditions and requirements of a given archaeological site, and the 

characteristics under which a camera is expected to be used during its lifetime. 

Archaeologists must choose cameras and related equipment based on cost, available 

lenses, accessories, and water-visibility of the archaeological sites to be recorded. The 

indicated total number of photos must be considered in order to allow a good choice of 

computing power and required storage capacity of the project’s computer.  

Under-exposure environments are another relevant problem in underwater 

photography; photos taken under water tend to be underexposed and have a marked shift 

to the blue side of the color spectrum. Hence, lower lighting environments call for the 

use of strobe lights to ensure proper exposure and solve the blue coloration problem 

(Fig. 2-3). Artificial light also solves the light-column problem caused by shadows 
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projected from the water surface in shallow water.  Two strobe lights with long 

articulated arms create the best and most flexible equipment arrangement for Computer 

Vision Photogrammetry (Fig. 2-4).  PhotoScan and other Computer Vison 

Photogrammetry software recognize pixel information to develop the depth in point 

clouds.  Shadows cast by strobe lights must be avoided because they change position 

from image to image, and do not reveal a stable color for the materials of the objects 

being recorded.  
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Figure 2-3. Photogrammetric models of the Gnalić shipwreck site (based on photos with/without strobe 

lights). The top model is based on photos taken with strobe lights (photos taken between August 4th and 

13th 2014), and the bottom photogrammetric model is based on photos taken without strobe lights (photos 

taken on July 18th 2014). As can be seen, the left model has more original colors of materials than that the 

right model. (Image: Yamafune) 
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Figure 2-4. Recommended underwater camera equipment. The housing is equipped with two strobe lights 

and an eight-inch hemispheric dome port. (Photo: Yamafune) 

 

 

Care must be taken to manage the capacity and duration of strobe light batteries. 

This is typically a difficult problem to resolve because the number of pictures required is 

always high; batches of 1,000 photos per dive may be necessary to ensure the proper 

coverage of a given site.  If the battery of a strobe light is exhausted during a 

photogrammetry dive, the colors in the photos before and after the battery failure will 

vary, and the PhotoScan Align Photos function will be seriously compromised.  Again, 

using DSLR cameras in conjunction with a strobe presents an added advantage, as their 

wider coverage reduces the total number of pictures required.  
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Underwater Coded Targets 

There is another practice related to underwater photography that increases the 

accuracy of Computer Vision Photogrammetry. As noted above, the proposed 

methodology in this dissertation uses Agisoft PhotoScan Professional Edition for 

Computer Vision Photogrammetry.  PhotoScan has four main steps for the 

photogrammetric modeling: Align Photos, Build Dense Cloud (a point cloud), Build 

Mesh (in which the Mesh is the surface of the model made up of polygons overlaid over 

the point cloud), and Build Texture.  The result can be improved using a number of 

relatively simple procedures.  One of these is the use of coded targets, an array of 

simple, unique images that PhotoScan uses to help identify the area being recorded.  

PhotoScan provides a collection of coded targets in PDF format, which can be 

printed at chosen sizes. Following a series of trials carried out at the Texas A&M Ship 

Reconstruction Laboratory (ShipLab) and in a nearby swimming pool in early 2014, the 

author found that targets with a center circle radii of between 5 and 10 mm worked best 

underwater. These values were selected for a camera with an APS-C sensor size, with an 

11 mm lens, shooting at a distance of 1.5 m.  The results of this laboratory testing were 

field-tested during the summer of 2014 when the author employed coded targets with a 

7.5 mm center circle radius at the Gnalić Project in Croatia.  The benefits of using coded 

targets to help the software align the photos were tremendous.  On 18 July 2014, the 

author placed 36 coded targets on the Gnalić shipwreck site prior to the photo-shooting 

session. That session required 1653 photos, which covered a 16 m x 12 m area. In the 

subsequent Align Photos process, the total number of successfully aligned photos 
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amounted to 100%, meaning that all 1,653 photos were successfully aligned (Fig. 2-5). 

When the author tried the function Align Photos using same images and settings, but 

without recognizing the coded targets, the total number of successfully aligned photos 

dropped to 804 (49% alignment). 

 

 

 
Figure 2-5. Sparse point clouds of the Gnalić shipwreck site on 18 July 2014 in PhotoScan. Number in the 

red circle indicates that 1,653 photos are aligned from 1,653 uploaded photos. The yellow and red dots on 

the point cloud model are coded target locations. Targets with red dots (selected targets) were also used as 

reference points, which have known coordinates. (Image: Yamafune) 

 

 

Because coded targets were designed for use on terrestrial sites, using them in 

water requires some special care. Before leaving for Croatia, the author prepared 80 
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coded targets for the Gnalić 2014 field season by waterproofing them with a thermal 

plastic lamination, as described below.  Some of the targets were fixed to the shipwreck 

structure during the entire two months of the excavation; the pristine condition of those 

targets at the end of the excavation validated the waterproofing technique for underwater 

target durability (Fig. 2-6).  

 

 

 
Figure 2-6. Underwater coded targets and their additional weights (zinc washers). (Photo: Yamafune) 

 

 

The targets were printed on Mylar (plastic paper) to take advantage of the 

transparency of the material. An important point to keep in mind is that targets must be 

printed using a laser printer; the toner of laser printers does not dissolve in water.  The 
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printed coded targets were then cut into individual pieces and glued on white plastic 

boards.  For the final step, the coded targets were laminated for additional durability and 

to create additional margins around the targets to allow the use of nails to fix the targets 

to the structure. For targets that needed to be moved to provide daily coverage, zinc 

washers were attached with duct tape to provide sufficient weight.  

PhotoScan can also automatically detect coded targets in any photo.  Using this 

function, coded targets are advantageous and can be used as reference points by 

recording known coordinates that are measured in situ, which are then input into the 

photogrammetry process in order to create 1:1 exact scaled photogrammetric models.    

 

Recommended Sizes for Coded Targets (Based on Focal Length and Distance) 

The print size of coded targets must be chosen based on camera choice and 

anticipated focal length.  To test successful recognition, the author prepared different 

sizes of coded targets:  center point diameter of 2.5 mm, 5.0 mm, 7.5 mm, 10.0 mm, 15.0 

mm, and 20.0 mm.  Twenty of each size of coded target were fixed on a wall, and photos 

were taken at different distances from the wall: 0.5 m, 1.0 m, 1.5 m, 2.0 m, and 3.0 m.  

The author used a Nikon D7100, an advanced amateur-level camera with APS-C sensor 

size. This examination was repeated using three different focal lengths: 11 mm, 18 mm, 

and 24 mm. Then all the photos were imported to PhotoScan, and automate marker 

detection was applied on those photos (with detection tolerance of 50). Tables below 

display the results (Table 2-8, 2-9, and 2-10).   
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Table 2-8. Coded targets recognition by a camera with 11 mm focal length (DSLR 

camera with APS-C sensor size) 
CTs Distance 

 

Center Point Radius 

0.5 m 1.0 m 1.5 m 2.0 m 3.0 m 

CTs 2.5 mm 100% × (95%) × (0%) × (0%) × (0%) 

CTs 5.0 mm 100% 100% 100% × (95%) × (5%) 

CTs 7.5 mm 100% 100% 100% 100% 100% 

CTs 10.0 mm 100% 100% 100% 100% 100% 

CTs 15.0 mm × (0%) 100% 100% 100% 100% 

CTs 20.0 mm × (0%) × (70%) 100% 100% 100% 

CTs 25.0 mm × (0%) × (0%) 100% 100% 100% 

 

 

Table 2-9. Coded targets recognition by a camera with 18 mm focal length (DSLR 

camera with APS-C sensor size) 
CTs Distance 

 

Center Point Radius 

0.5 m 1.0 m 1.5 m 2.0 m 3.0 m 

CTs 2.5 mm 100% 100% 100% × (0%) × (0%) 

CTs 5.0 mm 100% 100% 100% 100% 100% 

CTs 7.5 mm 100% 100% 100% 100% 100% 

CTs 10.0 mm × (0%) × (90%) 100% 100% 100% 

CTs 15.0 mm × (0%) × (0%) 100% 100% 100% 

CTs 20.0 mm × (0%) × (0%) × (65%) 100% 100% 

CTs 25.0 mm × (0%) × (0%) × (0%) × (15%) 100% 
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Table 2-10. Coded targets recognition by a camera with 24mm focal length (DSLR 

camera with APS-C sensor size) 
CTs Distance 

 

Center Point Radius 

0.5 m 1.0 m 1.5 m 2.0 m 3.0 m 

CTs 2.5 mm 100% 100% 100% × (90%) × (0%) 

CTs 5.0 mm × (45%) 100% 100% 100% 100% 

CTs 7.5 mm × (0%) 100% 100% 100% 100% 

CTs 10.0 mm × (0%) × (0%) 100% 100% 100% 

CTs 15.0 mm × (0%) × (0%) × (0%) 100% 100% 

CTs 20.0 mm × (0%) × (0%) × (0%) × (0%) 100% 

CTs 25.0 mm × (0%) × (0%) × (0%) × (0%) × (35%) 

 

 

These results suggest that a coded target will be recognized successfully when 

the diameter of its outer circle is shown between 80 pixels and 300 pixels in a photo 

(Fig. 2-7 and 2-8). This success range for target size should be confirmed for a specific 

camera at a specific focal length by taking a photo of a coded target to check if its outer 

circle has a pixel diameter between 80 pixels and 300 pixels.  

 



 

26 

 

 
Figure 2-7. Photo of coded targets shown in a minimum recommended size. Photo was taken by a camera 

with APS-C sensor (with 18 mm Focal Length and 2 m away from the CTs) (6000 x 4000 pixels / 300dpi). 

The series of targets in the center (7.5 mm center point radius) have 80 pixels at the outer circle. 80pixel 

diameter is a recommended minimum size for coded targets. (Photo: Yamafune) 

 

 

 
Figure 2-8. Photo of coded targets shown in a maximum recommended size. Photo was taken by a camera 

with APS-C sensor (with 18 mm Focal Length and 2.0 m away from the CTs) (6000 x 4000 pixels / 

300dpi). The targets (20.0 mm center point radius) have 300 pixels at the outer circle. 300 pixel diameter 

is a recommended maximum size for coded targets. (Photo: Yamafune) 
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Recommended Flight Path with Coded Targets 

As discussed above, photo alignment is the most important factor for successful 

photogrammetric modeling.  In order to maximize the probability of creating successful 

photo alignment, the author developed a flight path with coded targets for photo 

shooting.  Technically speaking, higher numbers of coded targets increase the accuracy 

of photo alignment; however, an excessive number of coded targets on shipwreck 

structures and artifacts may detract from the aesthetic appearance of the site, and may 

also cover important diagnostic features. To avoid placing coded targets directly on the 

wreck structure, the author recommends a flight path that places coded targets around a 

shipwreck structure to increase the accuracy of photo alignment (Fig. 2-9).  Furthermore, 

the best results have been achieved by capturing surrounding coded targets first to Lock 

the site. Then, photographs are taken perpendicularly to capture a top view of the site 

with appropriate overlap.  After complete photo shooting in both transversal and 

longitudinal paths, additional photographs must be taken with the camera tilted to 

capture vertical surfaces of rich tridimensional structures.  Actual flight path of 

archaeological sites can vary depending on multiple factors; therefore, meticulous 

planning of a flight path is an important part of successful photogrammetric recording.  

 



 

28 

 

 
Figure 2-9. Recommended flight path for photogrammetric recording. (Image: Yamafune) 

 

 

Local Coordinate Network 

 Tying the site plan to a set of local coordinates is a key factor of this workflow 

process. There are two reasons that creating a local set of coordinates is important: to 

correct scale and distortion of the photogrammetric models and to geographically 

reference the site plan.  

One of the advantages of Computer Vision Photogrammetry is that it does not 

require precise calibration of the camera. Although calibration is recommended, the 

software primarily uses pixel information to reconstruct a site, which means that the 

construction of the point clouds does not require manual calibration. Moreover, the 

software reads metadata from the camera and lens and minimizes the errors. Distortions 

are inevitable, however, and this factor alone argues for the necessity of establishing a 

set of precisely positioned datum points.  
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The second reason to establish a number of datum points is that unless tied to a 

system of coordinates, models float in unspecified tridimensional fields. To fix the 

models in the correct position, local coordinates have to be included on the models. 

Without this, it is impossible to export the computer graphics files to mapping software 

with the correct position. Georeferenced information facilitates a straightforward 

workflow when models and orthophotos (high resolution photomosaics) are exported. 

The processing and rendering capacity of the PhotoScan software is limited by both 

software and hardware configurations. This constrains the maximum polygon count for 

the mesh (which makes up the surface of the model), and the maximum number and 

resolution of UV mapped textures (‘UV’ is a XY coordinates for texture), which are 

composed photomosaic on surfaces of mesh. Large data sets can be divided into smaller 

Chunks (PhotoScan’s term), which are separately processed. These Chunks can be 

imported into other modeling and mapping software applications and merged without 

decimation (the reducing of the polygon count). When models and orthophotos are 

georeferenced, the merging process is automatic, and exported files are opened in their 

correct positions in other software. A set of local coordinates is paramount to ensure an 

accurate manipulation of models or orthophotos. 

During the Gnalić 2014 field season, the author and ShipLab team created a 

control network using eight datum points solidly fixed to the site bedrock and shored 

with sand bags. These eight points were positioned using 3H Site Recorder, a mapping 

software that uses statistical adjustment of trilateration, also known as Direct Survey 

Method (DSM). Depths of all points were taken with a depth gauge in rapid sequence to 
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avoid the effect of tide. Several measurements were taken and averaged (Fig. 2-10). The 

accuracy of DSM has been discussed and judged reliable by multiple sources (Atkinson 

et al., 1988; Rule, 1989; Green et al., 2002; Holt, 2003; Green and Gainsford, 2003). As 

Holt (2003) pointed out, the acquisition of direct measurements and manipulation of the 

software are very simple, but can generate errors when handled by novice divers alone. 

Holt (2003) recommends the use of experienced divers in this phase.  

 

 

 
Figure 2-10. Local coordinate network of the Gnalić shipwreck site from 2014 field season (in 3H Site 

Recorder). (Image: Reprinted with permission from Torres, 2014a) 

 

 

While several articles have discussed the accuracy of survey methods using 

trilateration (DSM), PhotoScan allows the input of measurements in a different way. 

PhotoScan uses scale bars, or known distance, instead of importing local coordinates 
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collected using DSM. At actual archaeological sites, establishing control points and local 

coordinates may take a week or two. This may not be suitable for a short-term survey 

project. This chapter discusses four different methods to fix distortions and scale of 

photogrammetric models. To test accuracy, local coordinates or known distances that 

were established using the four different methods were applied to a photogrammetric 

model. Then, the dimensions of the fixed models were compared with the control 

measurements to check relative accuracies. 

 

Methodology for Testing Different Local Coordinate Systems 

Measuring methods that will be discussed and compared in this chapter are: 

trilateration(DSM) using 3H Site Recorder, creating an enclosure using rope that is cut 

to known distances, scale bars that are placed on the site, and coordinates taken by total 

station. To compare and examine the accuracy of these four methods, local coordinates 

and known distances of these four methods were applied to a photogrammetric model, 

and each different method was compared to control measurements. The control 

measurements were taken directly from the wooden model. For this test, the author used 

a 1/10 scale wooden model of a saveiro, a 20th-century Brazilian coastal sailing boat. In 

order to simulate an archaeological shipwreck site, the wooden model was laid down on 

its starboard side, and its floor timbers were pulled slightly out so that its starboard 

futtocks lay on the bottom (Fig. 2-11). An historical and structural description of the 

original saveiro ship shall be discussed in Chapter VI. 
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Figure 2-11. Saveiro wooden ship model (1:10 size) for photogrammetry. This model was used for testing 

different survey methods that correct distortions and scales of a created photogrammetric model. (Photo:  

Yamafune) 

 

 

Trilateration (Direct Survey Method)  

The first method to discuss is trilateration, also known as Direct Survey Method 

(DSM). Trilateration (DSM) has been repeatedly used in underwater archaeological 

recordings. For this DSM, the author used 3H Site Recorder (Demo Version). In order to 

acquire coordinates of reference points, a control network first had to be established. The 

author placed eight control points around the wooden model, set all the control points to 

a congruent height (40 cm from the ground), and set this height as the surface of the 

water, or depth of 0 cm. To establish the positions of the control points, or a control 

network, 19 measurements were taken (Fig. 2-12). The tolerance established for errors 

was set at 0.3 cm; therefore, all distance errors bigger than 0.3 cm were shown in red 

(shorter) and blue (longer). Only one distance (CP5 – CP7) showed a + 0.39 cm 

statistical error after the adjustment of the control points. 
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Figure 2-12. The local coordinate network of datum points (control network) around the saveiro wooden 

model (Top view: horizontal plane). (Image: Yamafune) 

 

 

After the control network, or positions of datum points, was established, 11 

reference points were placed on the model. A total of 44 measurements were taken from 

the control points; each reference point was measured from the nearest four control points 

(Fig. 2-13 and 2-14). Two measurements indicated over 0.3 cm error; however, both errors 

were less 0.5 cm, which is within an acceptable range of error. After the local coordinate 

network of the saveiro model was established, XYZ coordinates of the reference points 

were extracted (Table 2-9). Then, these coordinates were plotted on the photogrammetric 

saveiro model. 
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Figure 2-13. The local coordinate network of reference points and control points around the saveiro wooden 
model (Top view: horizontal plane). (Image: Yamafune) 

 

 

 
Figure 2-14. The local coordinate network of reference points and control points around the saveiro wooden 

model (Front view: vertical plane). (Image: Yamafune)  

 

 

Table 2-11. Local coordinates of reference points based on DSM. (in 3H Site Recorder) 
Reference Points X coordinate (cm): 

(Easting) 

Y coordinate (cm): 

(Northing) 

Z coordinate (cm): 

(Altitude) 

R1 21.286 12.682 -3.755 

R2 159.698 -18.054 -11.948 

R3 69.658 21.771 -18.348 

R4 94.853 20.398 -19.842 
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Table 2-11 Continued 

 
R5 113.955 16.491 -18.990 

R6 62.489 -31.233 -24.989 

R7 85.599 -35.372 -26.887 

R8 107.292 -38.358 -24.991 

R9 64.402 -2.273 -28.310 

R10 88.080 -6.521 -28.613 

R11 112.957 -9.543 -29.085 

 

 

Enclosure    

The next method to be examined was designated the enclosure method. This 

method is based on the idea of enclosing an archaeological site using ropes (using 

measuring tapes as ropes is recommended) that are cut in predetermined, controlled 

lengths; therefore, the distances between the four corners will be known without having 

to take a series of tape measurements. Using the known distances that surround a site, 

distortions and scales of a photogrammetric model can be fixed. The relative coordinates 

of the four corners of any given site can be calculated using simple trigonometric 

equations or existing tools in CAD software. Additionally, using the Pythagorean 

Theorem, the angles of the four corners of a rectangular area can be exactly set at 90 

degrees (Fig. 2-15). To test the accuracy of the enclosure method, the author used the 

four corners of the base of the saveiro wooden model. These were measured: 101.2 cm at 

the stern, 101.5 cm at the bow, 182.8 cm at the starboard side, and 182.6 cm at the port 

side. The angle of each corner was measured at 90 degrees. The four distances were 

entered on the photogrammetric model (Fig. 2-16). 
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Figure 2-15. Examples of rope lengths for enclosure method. Using the Pythagorean Theorem, the angles 

of the corners can be controlled as 90 degrees. (Image: Yamafune)  

 

 

 
Figure 2-16. Distances between the four corners of the savairo wooden model for the enclosure method. 

(Image: Yamafune) 
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Scale Bars 

Scale bars are often used when pictures of archaeological sites are taken. These 

scale bars can be extremely useful in Computer Vision Photogrammetry. Scale bars give 

accurate scale information in archaeological photography, and when a site is being 

mapped using Computer Vision Photogrammetry, they can be used to check 

measurements after other methods, such as DSM, were used to correct distortion and 

scale of a created photogrammetric model. However, distortions and dimensions can be 

fixed by using only scale bars, a feature that allows archaeologists to skip the time 

consuming and sometimes inaccurate DSM system.  This may be one of the simplest 

methods used to record a site. To test the accuracy of this method, four scale bars were 

placed on the four sides of the saveiro model. In this particular case, considering the size 

of the model the four scale bars available were unnecessarily long. Therefore, seven 10 

cm scale bars with markers were created on the existing scale bars. These smaller 10 cm 

bars were entered as fixed distances in the photogrammetric model (Fig. 2-17). 
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Figure 2-17. Seven 10 cm scale bars created on the saveiro photogrammetric model for the scale bar method 

(Image: Yamafune)  

 

 

Total Station  

On terrestrial archaeological sites, total stations are used as an effective and easy 

way to acquire local coordinates; total stations cannot, however, be used in underwater 

environments. Nonetheless, not all shipwreck sites are submerged, and total stations are 

a widely used recording method known for accuracy. To compare the accuracy of the 

different methods described above, the coordinates of the saveiro model were also 

collected with a total station. A series of coordinates of control points and reference 

points were taken with a total station, and these points were plotted in Rhinoceros 3D-

CAD modeling software. Then all the points were re-oriented to match the coordinate 

system previously established, which has Control point 1 as the origin of the coordinate 
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system. Control point 1 (CP1) was attributed coordinates X=0, Y=0, Z=0, and control 

point 5 (CP5) was placed on the X-axis, or the easting line (Fig. 2-18). Coordinates of 

the reference points measured by the total station were shown in Table 2-12. 

 

 

 
Figure 2-18. Coordinates of the control points and reference points on the saveiro wooden model by total 

station that were plotted in Rhinoceros 3D CAD software. (Image: Yamafune) 

 

 

Table 2-12. Coordinates of the reference points measured by total station 

Reference Points X Coordinates (cm): 

 (Easting) 

Y Coordinates (cm): 

 (Northing) 

Z Coordinates (cm): 

 (Altitude) 

R1 22.17 12.30 -5.10 

R2 160.92 -18.67 -12.20 

R3 70.24 21.00 -18.80 

R4 95.97 19.94 -20.60 

R5 115.41 15.65 -19.10 

R6 62.11 -32.00 -25.20 

R7 85.94 -35.52 -26.80 

R8 108.43 -39.13 -24.90 

R9 64.38 -2.91 -28.70 

R10 85.94 -35.52 -26.80 

R11 114.30 -10.30 -29.40 
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Comparison of the Different Methods  

To test the accuracy of the survey methods mentioned above, the measurements 

from all photogrammetric models of the saveiro were compared within a single set of 

control measurements. The control measurements were taken directly from the wooden 

model; 21 selected distances between reference points were taken for this purpose (Fig. 

2-19). The control measurements were compared to the measurements obtained by the 

other methods, and corrected as indicated above (Table 2-13).  

 

 

 
Figure 2-19. The photogrammetric model of the saveiro wooden ship model and the 

measured distances between reference points for the comparison. (Image: Yamafune) 
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Table 2-13. Distances between reference points to compare different surveying methods 

to fix distortions and scales of the saveiro wooden ship models photogrammetric model 
 Control 

(cm) 

Trilateration 

(DSM) (cm) 

Enclosure (cm) Scale Bars (cm) Total Station 

(cm) 

R1 – R2 142.5 142.0 142.5 142.2 142.3 

R1 – R3 51.2 51.3 51.1 51.0 50.7 

R1 – R9  51.1 51.8 51.0 50.9 50.7 

R1 – R6 63.4 63.9 63.4 63.2 62.9 

R2 – R5 57.6 57.8 57.5 57.4 57.4 

R2 – R11 50.4 50.5 50.4 50.3 50.4 

R2 – R8 57.0 57.7 57.5 57.4 57.7 

R3 – R5 44.9 44.6 45.2 45.1 45.5 

R6 – R8  46.6 45.4 46.7 46.6 46.9 

R3 – R6 54.2 53.9 54.4 54.3 54.0 

R5 – R8 55.3 55.6 55.5 55.3 55.5 

R4 – R7 57.0 57.0 57.2 57.1 56.7 

R3 – R8 71.3 71.2 71.4 71.2 71.5 

R6 – R5 71.0 70.4 71.8 71.7 71.7 

Length of 

Keel  

115.2 115.0 115.4 

 

115.2 115.2 

Average 

Error  

 0.39 0.20 0.19 0.33 

 

 

The results suggest that trilateration (DSM) is not the most accurate method to 

correct scale in a photogrammetric model. The measurements taken from the 

photogrammetric model with trilateration (DSM) coordinates display an average error of 

0.39 cm, although the 3H Site Recorder software used in the trilateration (DSM) method 

indicated that the measurements between control points and reference points had errors 

of less than 0.3 cm. The second least accurate method in our experiment was the total 

station, but its 0.33 cm average error can be explained by the scale of the saveiro model. 

Total stations are designed to measure large distances and are less accurate when the 

measurements are this small. One must keep in mind that the nature of the total station 

suggests that this 0.3 cm error remains the same when the size of the site to be recorded 
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increases, making its accuracy better as the site size increases. The more accurate results 

obtained were through the enclosure method and the use of scale bars; the enclosure 

displayed an average error of 0.2 cm, and the scale bars allowed an average error of 0.19 

cm.    

 

Conclusion: Recommended Survey Method 

The results of the experiments discussed in this section show that the enclosure 

method and the scale bars method provided better results in fixing scales from Computer 

Vision Photogrammetry surveys. The main disadvantage of trilateration (DSM) is that it 

requires many measurements. For instance, the saveiro model required 19 measurements 

to establish the control point network and 44 measurements to calculate the coordinates 

of reference points. On the other hand, the enclosure method only required four 

measurements (six measurements if you use the Pythagorean Theorem) plus the depths 

of the corners of the area. The scale bar method does not require any measurements. 

However, it is important to note that the enclosure and the scale bars methods cannot 

establish a local coordinates system. This is a disadvantage when compared to the 

traditional trilateration (DSM) method; the enclosure and scale bars can fix distortion 

and scale of photogrammetric models, but they need a complementary method to 

establish local coordinates. Other surveying methods will be proposed in the following 

sections of this dissertation that take advantage of the accuracy and simplicity of the 

enclosure and scale bars methods while simultaneously allowing the archaeologist to 

acquire a local system of coordinates.  
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These surveying methods require only three steps. The first step is to create a 1:1 

scale photogrammetric model using both enclosure and scale bars. The second step is to 

place the model in a 3D field using one of the corners as a datum point (X=0, Y=0, Z=0) 

and calculating the remaining corners using the measurements from the enclosure 

method. To add the depth of the site and correct the enclosure – if it turns out not to be 

an exact square or rectangle – simple trigonometry or CAD software can be used for 

minor adjustments. The third and final step is to extract the coordinates of the reference 

points marked inside the enclosure and over the structure to be recorded. Coded targets 

may help expedite this process, another reason to employ coded targets during the first 

photo-shooting session for the photogrammetry model. In the end, this method 

establishes a local coordinate system using a 1:1 scale photogrammetric model of the 

site. 

This base model can be created at the beginning of the field season—it is simple 

and accurate. Based on site experience, the establishment of a local coordinate system 

using trilateration (DSM) may take five to ten days with a shipwreck that is larger than 

20 m. The methodology presented in this section takes only two to three days to establish 

a local coordinate system and also produce the first photogrammetric model of the site.  

Nonetheless, the author still consider that Direct Survey Methods is very reliable 

survey methods in terms of establishing the XYZ local coordinate systems. 

Henceforward, careful planning for choice of survey methods (based on available 

budgets, time, and personnel) is strongly recommended before the field season.  
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Data Collection and Database 

The author shall only briefly discuss data collection and database management in 

this dissertation; however, it must be noted that data collection and database 

management are the most important tasks during field projects. Newly developed 

technologies and ideas certainly can help to accelerate archaeological field projects, yet 

they cannot replace many necessary conventional tasks performed by archaeologists and 

other scholars. The author has learned several computer drafting and modeling software 

suites to facilitate archaeological work; however, full exploitation of software 

capabilities requires shipbuilding knowledge and archaeological training in addition to 

software proficiency.  For instance, if young nautical archaeologists want to learn 

Rhinoceros 3D CAD design software to employ on ship reconstruction, they must first 

know how to draw hull lines by hand. Today various computer programs automate 

processes that archaeologists have long done by hand, and computers can perform 

mathematical calculations of reconstructed ships, such as water displacement and 

coefficients. However, a fundamental understanding of the applicable facets of nautical 

archaeology, based on the history of shipbuilding and a ships historical context, is 

paramount to successful application of software to a specific excavation.  

It cannot be overemphasized that data collection is a first step and most important 

task in field projects. Without good data collection in the field, the workflow being 

discussed in this dissertation is useless. 
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Data Collection 

Data collection as discussed in this methodology is conventional data collection 

by hand.  Even when archaeologists can create an accurate 1:1 scale photogrammetric 

model and extract any desired measurements from the created model, these are just 

measurements. To truly understand the shipbuilding techniques employed during 

construction of the ship, sketches made by trained archaeologists are critical (Fig. 2-20). 

Archaeological training is crucial in the selection of hull areas of interest and specific 

components to be recorded; a profound knowledge of shipbuilding is invaluable in the 

field as well as during reconstruction in the laboratory. 

 

 

 
Figure 2-20. Example of an underwater sketch by an archaeologist. (Photo: Reprinted with permission 

from Castro, 2014a) 
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Two prerequisite tasks in fieldwork site preparation are digging and subsequently 

cleaning the archaeological site (Fig. 2-21). A basic concept in the discipline of 

archaeology is that excavation results in the destruction of archaeological sites (with 

precise recording). Nonetheless, careful excavation supervised by trained archaeologists 

can minimize unnecessary damage to shipwreck sites. Additionally, good recording, 

including Computer Vision Photogrammetry, requires good cleaning; in other words, the 

results obtained in recording are largely dependent on traditional methods of excavation 

and cleaning archaeological sites; both tasks require experience and training.  

 

 

 
Figure 2-21. A working scene of archaeologists on the Gnalić shipwreck. An archaeologist on the right is 

recording provenience of an artifact while others are excavating and cleaning the wooden structure. 

(Photo: Reprinted with permission from Pandozi, 2014) 
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At all shipwreck sites, archaeologists find various artifacts during excavation. 

When artifacts are removed from the site during the project, it is important to record the 

provenience of all artifacts and to take photos.  Artifacts brought to a project’s base or a 

laboratory for conservation must be stored and recorded properly under the supervision 

of conservation specialists (Fig. 2-22 and 2-23). When there is no space, funding, or 

plans for proper conservation, it is unwise (and often illegal) to remove artifacts from the 

archaeological site. Preservation of artifacts in situ, while not ideal, is preferable to the 

artifact compromise and destruction that will be caused by removal and failure to 

conserve.  Each artifact provides potentially valuable information; the excavating 

archaeologist has a duty to maximize the information obtained from each artifact while 

minimizing destruction and loss.   

 

 

 
Figure 2-22. An artifact from the Gnalić shipwreck site being chemically treated by Chris Dostal and 

Katarina Batur, conservation specialists, in the temporary laboratory of the Gnalić Project. (Photo: 
Reprinted with permission from Govorčin, 2014) 
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Figure 2-23. Artifacts raised from the Gnalić shipwreck site were recorded and stored in an organized 

manner by archaeologists and conservators (Carla Pereira). (Photo: Reprinted with permission from Batur, 

2014a)   

 

 

Database 

Information about artifacts from shipwreck sites and the associated photos must 

be organized properly so that project information can be easily retrieved in the future. 

Moreover, all underwater sketches and diaries of archaeologists and divers who 

participate in a project should be scanned or photographed every day and stored in the 

database.  Traditionally, nautical archaeologists have preferred a paper-based database.  

The author strongly recommends the use of a database in digital format, which can easily 

be duplicated, transferred, and shared, and theoretically can last forever. For example, 

during three seasons of the Gnalić project, recovered artifacts were recorded and 

photographed properly, and the data stored in a digital database (Fig. 2-24 and 2-25). 

The second primary reason to use a digital database is that archaeologists can link data to 
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GIS-based mapping software to create a geo-referenced database, making spatial 

analysis of artifacts and ship structure possible.  The author will explain GIS-based 

mapping and database in Chapter III. 

 

 

 
Figure 2-24. Photo database of the Gnalić artifacts. All raised artifacts were photographed and organized 

in digital database. (Image: Reprinted with permission from Batur, 2014b) 

 

 

 
Figure 2-25. Digital database of the Gnalić Project 2014 field season. All raised artifacts were measured 
and briefly analyzed by conservators and archaeologists. Applicable information were entered into the 

digital database in an organized manner. (Image: Reprinted with permission from Batur, 2014c) 
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It must be noted that database development is one of the most important tasks in 

archaeological projects; future accessibility of the collected data depends completely on 

the database.  This may be the most difficult task in an archaeological field project. 

Often inexperienced archaeologists and attending divers do not recognize the importance 

of data organization. Project directors must emphasize the importance of this task and 

assign dedicated attending archaeologists and students to managing data organization 

and storage. Without good organization, important information may be lost forever.  

In summary, manual data collection and the subsequent development of a well-

organized database in digital format are the most important steps in any archaeological 

project; without accomplishing these two tasks, the methodology outlined in this 

dissertation is useless. 
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CHAPTER III 

DATA PROCESSING 

 

Computer Vision Photogrammetry (Agisoft PhotoScan) 

The author was in charge of photogrammetric modeling of the Gnalić shipwreck 

during the 2014 field season, and this chapter is a reflection on that experience. During 

the excavation, several photogrammetric models of the Gnalić shipwreck site were 

created using Agisoft PhotoScan (professional edition). (in 2015) Photoscan professional 

edition costs $3,499 for a stand-alone license and $549 for an educational license. 

Photoscan was first released in the middle of 2010 as a mapping software based on aerial 

photography, but was soon appropriated by other disciplines, including architecture, the 

motion picture industry, and terrestrial and underwater archaeology. To reconstruct 

tridimensional structures of a given scenario or landscape, PhotoScan uses an algorithm 

that was developed in a discipline called Computer Vision. Computer Vision is a sub-

discipline of computer science that was designed to help robotic devices to understand 

surrounding structures (Van Damme, 2015; Huang 1996; Szelski, 2010). Computer 

Vision algorithms find common features among images of a given target, taken from 

different angles, and process those images to derive depths of the structures mapped 

(Van Damme, 2015; Szelski, 2010).  In the author’s opinion based on working with 

multiple software suites, off-the-shelf PhotoScan software is more accurate and user-

friendly than other available photogrammetry software.  The workflow of PhotoScan has 

four basic steps: Align Photos, Build Dense Cloud, Build Mesh, and Build Texture. This 
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workflow is simple, but each step must be executed properly. The author has developed 

a number of additional tasks with associated sub-settings of basic workflow processes of 

PhotoScan to optimize the results of these processes. Unfortunately, the user manual of 

PhotoScan does not address the factors and influences of each sub-setting. In order to 

fully understand the meanings and functions of these sub-settings to optimize output 

results, the author conducted an experiment in which he produced photogrammetric 

models of two cubes with different surface patterns. Those photogrammetric models 

were processed using different sub-settings (Fig. 3-1). Although the user manual of 

PhotoScan does not fully explain the nuances of sub-settings, Photoscan programmers 

and professional users argue differences and advantages of various sub-settings to 

optimize PhotoScan output on Agisofts forum pages (Agisoft Online Forum, 2015). The 

starting point for some of the specific sub-settings tested was selected by review of those 

forum pages. In all cases, the settings provided below were developed from testing, 

rather than from accepting forum discussions at face value. 

 

 

 
Figure 3-1. A Photogrammetric model of two cubes. Each face of each cube has a different patterned 

texture image. (Image: Yamafune) 
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Align Photos  

After uploading photos into the program, the first step of photogrammetric 

modeling is Align Photos. One of the forum discussions (Alignment Experiments by 

[handle name] Marcel) discusses Align Photos settings (Marcel, 2015). Align Photos has 

three different Accuracy settings: High, Medium, and Low. High Accuracy uses full 

resolution images, Medium uses 50% resolution, and Low uses 25% resolution. The next 

sub-setting is Pair Pre Selection; this sub-setting allows PhotoScan to perform a quick 

pre-scan before it begins full common feature detection in photo. This quick pre-scan 

can detect two photos that share similar views. Based on this pre-scan, PhotoScan can 

skip the whole image point detections to align each single photos. Instead, it only scans 

two pre-selected images each time to locate camera position. As a result, employing Pair 

Pre Selection reduces processing time.  Pair Pre Selection has Generic and Disabled 

options. To activate pre selection, Generic must be selected.  

The next Align Photos setting of interest is Key Point Limit. This setting 

specifies how many pixels PhotoScan uses from each photo to detect common features 

in images. The default setting of Key Point Limit is 40,000 (for reference, a typical 36 

Megapixel photo has approximately 240,000 pixels, and a 21 Megapixel photo has 

approximately 180,000 pixels). One Agisoft forum discussion stated that selecting a 

higher number for Key Point Limit will increase the processing time until the value 

reaches 240,000, supporting full processing of photos having 36 Megapixels (240,000 

pixels). However, the forum also noted that if the setting chosen for Key Point Limit is 

more than 40,000, there will be no improvement in the quality of Dense Clouds in 
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subsequent processing. Thus if accuracy is the primary concern, projection error can be 

minimized to 0.3 pixel by increasing Key Point Limit to 120,000 (although an average 

projection error with Key Point Limit set to 40,000 is 0.7 pixels--already less than 1 

pixel) (Marcel, 2015). The author tested the Align Photos process with Key Point Limit: 

40,000 (default) and Key Points Limit: 80,000 (Fig. 3-2 and 3-3). No significant 

difference was noted in the development of the created sparse points. 

 

 
Figure 3-2. Align Photos process with Key Point Limit: 40,000 (default) setting. Total number of created 

sparse points was 18,489. (Image: Yamafune) 
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Figure 3-3. Align Photos process with Key Point Limit: 80,000 setting. Total number of created sparse 

points was 18,148. (Image: Yamafune) 

 

 

The last sub-setting of the Align Photos stage is Tie Point Limit, which specifies 

how many detected common points are actually used to calculate the depth of the scene. 

For instance, when 40,000 Key Point Limit and 1,000 Tie Point Limit are applied, 

40,000 points of each image are used to detect common points to match images, and then 

the 1,000 highest quality common points from each image are used to calculate camera 

positions and to create sparse point clouds. Decreasing the Tie points setting decreases 

the processing time of photo alignment (Pasumansky, 2015).  During the Align Photos 

stage the author used a setting of Tie Point Limits: 1,000 (default) and Tie Point Limit 

2,000; doubling the number of tie point limits more than doubled the number of created 

sparse points, but at a cost of a significantly longer processing time (Fig. 3-4 and 3-5).  

Judging from the results, the Tie Point Limits value directly affects the total number of 

sparse points. The author elected not to perform experiments on the Quality sub-setting 
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at this stage of processing because successful photo alignment largely depends on photo-

shooting, not Quality sub-settings. 

 

 

 
Figure 3-4. Align Photos process with Tie Point Limits: 1000 (default) setting. Total number of created 

sparse points was 18,489. (Image: Yamafune) 

 

 

 
Figure 3-5. Align Photos process with Tie Point Limits: 2000 setting. Total number of created sparse 

points was 42,651. (Image: Yamafune) 



 

57 

 

Build Dense Cloud 

Once photos are aligned, the next step is Build Dense Cloud. This process has 

five quality settings: Ultra High, High, Medium, Low, and Lowest. Ultra High quality 

uses full size image resolution, High uses 50% of the original scale, Medium uses 25%, 

Low uses 12.5%, and Lowest uses 6.75%. These percentages directly affect the total 

number of points in the dense cloud (Marcel, 2014) (Fig. 3-6, 3-7, 3-8, and 3-9). For this 

test, the author intentionally skipped a trial of the Ultra High sub-setting because once 

the computer began processing, it provided an estimated processing time of more than 

two weeks. Thus, this setting is not practical for typical archaeological projects, which 

are usually conducted without the services of a super computer.  

 

 

 
Figure 3-6. Accuracy: High setting on Build Dense Cloud process. Total number of the points is 

38,283,371. (Image: Yamafune)   
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Figure 3-7. Accuracy: Medium setting on Build Dense Cloud process. Total number of the points is 

9,979,748. (Image: Yamafune) 

 

 

 
Figure 3-8. Accuracy: Low setting on Build Dense Cloud process. Total number of the points is 

2,573,953. (Image: Yamafune) 

 

 



 

59 

 

 
Figure 3-9. Accuracy: Lowest setting on Build Dense Cloud process. Total number of the points is 

644,590. (Image: Yamafune) 

 

 

Another sub-setting is Depth Filtering. This filter has four selectable options: 

Disabled, Mild, Moderate, and Aggressive. The Aggressive option means that if the 

object is monotone, PhotoScan will recognize it as void space and will not create points 

within that space (Fig. 3-10). Selecting the Mild option prompts the program to 

recognize monotone areas as objects, and to create points within those spaces (Fig. 3-

11). For example, the Aggressive depth filter does not recognize the surface of a white 

board as an object, and it creates a hole in its photogrammetric model; on the other hand, 

the Mild setting may recognize blue sky as a blue object, and thus create point clouds in 

what would otherwise be void space. Therefore, Mild works well on a monotone surface, 

and Aggressive works well with images that contain actual void spaces.  Moderate 

filtering works between the previous two filtering options (Fig. 3-12). Disabled mode 

does not recognize depth; in other words, if an object has a monotone colored surface, 

PhotoScan does not regard it as a surface and creates void spaces (Fig. 3-13). In 
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summary, each depth filtering selection has advantages and disadvantages, therefore the 

Depth Filtering setting must be chosen based on photography conditions. 

 

 

 
Figure 3-10. Build Dense Cloud process with Depth filtering: Aggressive setting. (Image: Yamafune) 

 

 

 
Figure 3-11. Build Dense Cloud process with Depth filtering: Mild setting. (Image: Yamafune) 
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Figure 3-12. Build Dense Cloud process with Depth filtering: Moderate setting. (Image: Yamafune) 

 

 

 
Figure 3-13. Build Dense Cloud process with Depth filtering: Disabled setting. (Image: Yamafune) 
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Build Mesh 

The next process is Build Mesh (mesh is the geometry of the created model based 

on the point cloud). Sub-settings for this process are Surface Type, Source Data, Face 

Count, Interpolation, and Point Classes. Surface Type has options Height Field and 

Arbitrary; when the subject of photogrammetric modeling is a flat structure, such as a 

level field (ex. aerial photography), Height Field is sufficient; however, if an object has 

3D structure, Arbitrary must be selected (Fig. 3-14 and 3-15).  From Source data, either 

Sparse Cloud or Dense Cloud may be chosen. In general, Dense Cloud is preferable 

since it generates more minute details.  

 

 

 
Figure 3-14. Build Mesh process with Surface Type: Arbitrary setting. (Image: Yamafune) 
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Figure 3-15. Build Mesh process with Surface Type: Height Field setting. (Image: Yamafune) 

 

 

The Face Count (Face Count means total number of the created surface of mesh) 

sub-setting has High, Medium, and Low options; High creates faces, or surface of 

meshes, that are made of 1/5 of the number of points in the Dense point cloud, Medium 

creates 1/15 of the point cloud (1/3 of the High setting), and Low creates 1/45 of the 

point cloud (1/9 of the High setting) (Fig. 3-16, 3-17 and 3-18).  
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Figure 3-16. Build Mesh process with Surface Count: High setting. Total face count is 1,862,579. (Image: 
Yamafune) 

 

 

 
Figure 3-17. Build Mesh process with Surface Count: Medium setting. Total face count is 620,856. 

(Image: Yamafune) 
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Figure 3-18. Build Mesh process with Surface Count: Low setting. Total face count is 206,952. (Image: 

Yamafune) 

 

 

Another sub-setting is Interpolation. This sub-setting has three options: Disabled, 

Enabled (default), and Extrapolated. Disabled accurately reconstructs meshes based on 

point clouds (Fig. 3-19). Alternatively, Enabled measures a certain diameter from each 

point and creates meshes as if the separated points were located within the diameter; in 

short, it automatically fills small holes (Fig. 3-20). Extrapolated creates meshes between 

separate points and aggressively fills holes, including large holes (Fig. 3-21).  

Consequently, if the purpose of a photogrammetry project is to acquire accurate 

archaeological data, the Disabled Interpolation setting is preferred. On the other hand, 

when visualization is the main goal of the photogrammetric modeling, Enabled is the 

better choice.  
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Figure 3-19. Build Mesh process with Interpolation: Disabled setting. (Image: Yamafune) 

 

 

 
Figure 3-20. Build Mesh process with Interpolation: Enabled setting. (Image: Yamafune) 
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Figure 3-21. Build Mesh process with Interpolation: Extrapolated setting. (Image: Yamafune) 

 

 

The last sub-setting is Point Classes. This sub-setting is for GIS-based mapping 

software; it allows point clouds to be imported from mapping software. They can be 

classified into different categories, such as Ground, Vegetation, Building, Water, etc. 

This sub-setting allows PhotoScan to read the categories assigned by GIS mapping 

software, and then create meshes of chosen point types.    

 

Build Texture  

The final step of the PhotoScan workflow is Build Texture. In this process, 

PhotoScan creates a photomosaic and places it on the surface of the meshes. The first 

sub-setting is Mapping Mode; this applies methods of UV mapping of created textures.  

UV mapping creates a 2D atlas, or a canvas on which textures can be projected. Options 

for the Mapping Mode sub-setting are Generic, Adaptive Orthophoto, Orthophoto, 
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Spherical, Single Camera, and Keep UV. The default setting is Generic; with this option, 

PhotoScan automatically chooses the best photos (based on cubic projection) and 

composes a UV of meshes into texture atlases in order to convert the 3D structure of 

meshes into a 2D image format of created textures.  This mode is preferred for more 

complicated models that have 3D structures (Fig. 3-22). Orthophoto creates a 

photomosaic from a projection plane (generally, a top view plane) and projects a created 

photomosaic onto the meshes (Fig. 3-23). Differently from Orthophoto, Adaptive 

Orthophoto detects vertical faces and creates textures independently for those side 

meshes (Fig. 3-24). Spherical mode creates a UV map for ball-like, spherical structures. 

A texture atlas is a 2D plane; therefore, texturing a spherical shape requires a unique 

mapping projection (similar to world maps and globes). However, this mode is only 

suitable for spherical structures (Fig. 3-25). Single Photo creates texture based on one 

photo; a photo can be chosen from any photo in the active Chunk. Keep UV is for 

importing a UV map created in different software. Many modeling softwares allow the 

creation of texture on meshes. This process also includes creating UV maps. If UV maps 

that were created in different software are preferred, PhotoScan can use imported UV 

maps in the Build Texture process. 
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Figure 3-22. Build Texture process with Mapping Mode: Generic setting. (Image: Yamafune) 

 

 

 
Figure 3-23. Build Texture process with Mapping Mode: Orthophoto setting. (Image: Yamafune) 
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Figure 3-24. Build Texture process with Mapping Mode: Adaptive orthophoto setting. (Image: Yamafune) 

 

 

 
Figure 3-25. Build Texture process with Mapping Mode: Spherical setting. (Image: Yamafune) 
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Another Sub-setting is Blending mode. To clarify, Mapping Mode is used to 

compose UV maps, and Blending mode is used to compose selected photo-images on 

created UV maps as textures. Blending mode has five options: Mosaic, Average, Max 

Intensity, Min Intensity, and Disabled. The default blending mode is Mosaic. This 

setting selects the closest photo to corresponding surfaces and uses that image without 

blending with other overlapping photos. (Fig. 3-26) The Average sub-setting calculates 

an average pixel value, or RGB value of colors, of overlapping photos and uses those 

pixel values as textures. (Fig. 3-27)  The Max Intensity setting applies images that have 

maximum intensity, or bright pixels, to corresponding surfaces (Fig. 3-28). The Min 

Intensity setting is opposite of the Max Intensity setting; it uses minimum intensity 

images. The Disable setting is, again, for imported models that already have suitable 

textures (Fig. 3-29). In conclusion, based on the author’s experiences, Mosaic provides 

the best result among those sub-settings; therefore, Mosaic is preferred for creating 

textures on archaeological photogrammetric models. 
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Figure 3-26. Build Texture process with Blending Mode: Mosaic setting. (Image: Yamafune) 

 

 

 
Figure 3-27. Build Texture process with Blending Mode: Average setting. (Image: Yamafune) 

 

 



 

73 

 

 
Figure 3-28. Build Texture process with Blending Mode: Max Intensity setting. (Image: Yamafune) 

 

 

 
Figure 3-29. Build Texture process with Blending Mode: Min Intensity setting. (Image: Yamafune) 
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Photogrammetric Model of the Saveiro Wooden Ship Model 

With an acquired understanding of PhotoScan workflow and the consequences of 

its sub-settings, the author tried to create a photogrammetric model of the saveiro 1:10 

scale wooden ship model. A total of 611 photos were taken and uploaded into 

PhotoScan. These photos overlapped each other well. Additionally, eight coded targets 

were placed on the model to aid in photo alignment; consequently, all 611 photos were 

aligned successfully in PhotoScan. For the Align Photos process, the author used 

Accuracy: High, Pair Pre Selection: Generic, Key Point Limit: 40,000, and Tie Point 

Limit: 1000 settings.  The next step was Build Dense Cloud. For this process, Quality: 

Medium, and Depth filtering: Mild settings were applied.  However, the result was not 

successful because unnecessarily dense clouds were created between frames (Fig. 3-30). 

To avoid the points formed between frames, Disabled depth filtering was applied; 

however, unnecessary points were still created.  All photos were then reviewed, and it 

was noted that some obliquely taken photos displayed sides of frames as if there were 

timbers between frames (Fig. 3-31). Subsequently, the author disabled 247 photos that 

were taken diagonally (hence reducing the total number of active photos to 364).  

It must be noted that those disabled photos should not be deleted for the entire 

workflow process; all 611 photos should be used in the Align Photos stage because 

maximizing the number of overlapped photos helps PhotoScan align photos.  Therefore, 

disabling photos, if required, should be done after photo-alignment is completed. 

Accordingly, Build Dense Cloud was applied with 364 photos. The result of this process 

was drastically improved by disabling obliquely taken photos (Fig. 3-32).  
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Figure 3-30. Dense Point Cloud of the saveiro wooden ship model. Unintended points were created 

between frames. (Image: Yamafune) 

 

 

 
Figure 3-31. An example of photos of the saveiro wooden model that were disabled for Build Dense 

Cloud process. The photo was taken obliquely; therefore it displayed sides of frames as if there were 

surfaces between frames. (Photo: Yamafune) 
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Figure 3-32. Dense Points Cloud of the saveiro wooden ship model after 247 oblique angle photos were 

disabled (processed with 364 photos). (Image: Yamafune) 

 

 

After manually deleting unnecessary floating points, the Build Mesh process was 

applied.  For this test, the author intended to use the saveiro model for two different 

purposes: 1) visualization purposes (local coordinates system in Chapter II) and 2) 

archaeological data purposes (section profiles in Chapter III).  Therefore, two different 

sub-settings were chosen and applied on two duplicated dense cloud models. The 

visualization model sub-settings selected were Surface Type: Arbitrary, Source Data: 

Dense Cloud, and Interpolation: Enabled. The archaeological data model sub-settings 

selected were: Surface Type: Arbitrary, Source Data: Dense Cloud, and Interpolation: 

Disabled. Thus the only difference between the processing of the two models was the 

Interpolation sub-setting. The Interpolation: Enabled sub-setting tends to fill holes on 

surfaces, yet it sometimes creates meshes among void spaces. Contrarily, the 
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Interpolation: Disabled sub-setting creates meshes only where points are closely located; 

therefore, the created meshes contain more accurate archaeological data. The problem 

with the Interpolation: Disabled sub-setting is that created photogrammetric models tend 

to contain small floating meshes, or noisy dust-like surfaces. This noisiness makes UV 

mapping difficult in the Build Texture stage. Consequently, the Interpolation: Enabled 

sub-setting was preferred for building high quality texture to support visualization. 

Before proceeding to the Build Texture process, both models were decimated 

(simplified). Each model had approximately 2,000,000 faces; the excessive number of 

faces may compromise quality of textures because face count constrains spaces on UV 

maps; therefore, total model face counts should be decreased as much as feasible, while 

still maintaining the original shape of the source. Thus, both photogrammetric models 

were decimated from 2,000,000 faces to 500,000 faces. Also, to acquire maximum 

quality textures, the previously disabled 347 diagonally shot photos were re-enabled. 

Then the photogrammetric model for visualization purposes was processed in the Build 

Texture stage using the sub-settings Mapping Mode: Generic, Blending mode: Mosaic, 

and Texture size/count: 6000 x 3. The result was satisfactory (Fig. 3-33).  
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Figure 3-33. Finished Photogrammetric model of saveiro wooden ship model that is intended to be used 

for visualization purposes. (Image: Yamafune) 

 

 

Another photogrammetric model made for archaeological data purposes was first 

processed with the same sub-settings as the visualization purposes model, but the result 

was not good.  The poor texture was caused by noisy floating meshes because these tiny 

faces required individually separated spaces on UV maps. In other words, to acquire 

good archaeologically diagnostic textures on the created 3D model, meshes of the model 

must have a clean appearance. To solve this problem, the author deleted peripheral parts 

of the photogrammetric model. Then the Build Texture process was applied with 

Mapping Mode: Generic, Blending mode: Mosaic, and Texture size/count: 6000 x 3 

settings. The result was satisfactory (Fig. 3-34).  
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Figure 3-34. Finished Photogrammetric model of the saveiro wooden ship model that is intended for use 

as a source of archaeological data, or a reconstruction of the original shape of the frames. In order to get 

better texture, peripheral meshes were removed. (Image: Yamafune) 

 

 

To summarize the above discussion, photogrammetric modeling in PhotoScan is 

not always successful on the first attempt.  However, by disabling or enabling 

appropriate photos before each process, many problems can be addressed. Additionally, 

the results of processes differ based on selected sub-settings; therefore, the ultimate 

purpose of the model must be taken into account when creating a photogrammetric 

model.  In the following section, the author shall introduce other ways to solve problems 

of photogrammetric modeling by using exporting and importing tools in PhotoScan.  

 

Modeling a Sail (Mesh Replacement Techniques)  

It is difficult for Computer Vision Photogrammetry to recognize thin objects and 

monotone objects. However, using the exporting and importing features of PhotoScan, 
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created models can be exported to different software to add desirable meshes. Then, the 

modified models can be re-imported to PhotoScan to apply textures. For example, 

PhotoScan has great difficulty constructing meshes to model the sails of a ship.  The 

author copes with this difficulty by employing the exporting and importing features of 

PhotoScan. When the author applied Computer Vision Photogrammetry on a Chinese 

junk ship model, meshes cannot be created on the sail because it was too thin (Fig. 3-35). 

Similar failures of photogrammetric modeling often occur when subjects contain 

monotone faces. When this failure happens, PhotoScan cannot solve these problems 

automatically in the software. However, using export mesh and import mesh commands, 

void spaces can be filled with desirable mesh from a different software (Fig. 3-36).  

However, it is important to maintain the models original spatial position; then, the model 

can be re-imported to PhotoScan at the exact same location as before it was exported. 

 

 

 
Figure 3-35. Photogrammetric model of a Chinese junk model with unsuccessfully reconstructed sail. 

Often sails are too thin to be reconstructed by photogrammetric software. (Image: Yamafune) 



 

81 

 

 
Figure 3-36. Sail of a Chinese junk model reconstructed in Autodesk Maya modeling/animation software. 
Also, this can be done in other modeling softwares, for instance Rhinoceros 3D CAD modeling software. 

(Image: Yamafune) 

 

 

As a result of this export and import void filling and mesh processing, the Build 

Texture process can now adequately process the original photos and new texture will be 

created on the edited meshes (Fig. 3-37). This technique is also useful when the created 

mesh has holes because of the monotone coloration problem. This technique may be 

useful when photogrammetric modeling of ships models or actual sailing ships is 

desired.  Moreover, this export and re-import technique can be used for any 

photogrammetric model; if some parts of an object’s model cannot be created, these 

parts can be added in another modeling software, and then textures can be created on re-

imported models in PhotoScan. 
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Figure 3-37. Photogrammetric model of a Chinese junk with edited sail after re-importing to PhotoScan 

from Maya, then “Build Texture” was applied to the model. (Image: Yamafune) 

 

 

Video Frame Photogrammetry 

Another potential use of Computer Vision Photogrammetry is Video Frame 

Photogrammetry. The idea of video frame photogrammetry is to extract still frames from 

video footage and use those frame images as photos for Computer Vision 

Photogrammetry. The basic Workflow of photogrammetric modeling in PhotoScan is the 

same; the difference is in the source and preparation of images. The author used two 

different techniques to extract still frames from video footage: selective extraction and 

automatic extraction.  

Automatic extraction is a way to automatically select still frames based on video 

frame quality and the position of the camera. Selective extraction is a more flexible 

method in terms of photo alignment because the video processor has total control over 
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the selection of crisp still frames and the overlap between frames. Since cameras 

shooting video do not control shutter speed, some still frames are subject to motion blur; 

therefore, selecting crisp still frames from video footage is important. For the selective 

extraction, the author used Adobe Premiere Pro CS6 video editing software. Using this 

software, any still frame can be extracted and saved in Jpeg format with one click (Fig. 

3-38). A major disadvantage of the selective extraction technique is its labor intensity 

because frames have to be manually selected. Based on the author’s experiences, 

extracting still frames from a ten minute long video takes approximately one to two 

hours; video footage has 24 to 30 still frames per second, thus a ten minute video will 

have in excess of 14,000 embedded still frames.  

 

 

 
Figure 3-38. Manual extraction of still frames using Adobe Premiere Pro CS6. (Image: Yamafune) 
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Automatic extraction is another video extraction option. Using this method, still 

frames can be extracted automatically. The author used Adobe Photoshop CS6 for the 

automate extraction. The Photoshop software series is typically employed as image 

editing software, yet it can also edit video files. Using Photoshop, lengths of video 

footage may be trimmed, and still images from video footage may be exported at a 

controlled frequency (i.e. the number of frames extracted per second of video is 

selectable) (Fig. 3-39).  This extraction is an automated process; thus, specific frames 

cannot be chosen for use in Computer Vision Photogrammetry. Consequently, some of 

the still frames automatically exported may be subject to motion blur.  

 

 

 
Figure 3-39. Automate extraction of still frames using Adobe Photoshop CS6 (Image: Yamafune) 

 

 



 

85 

 

The images that suffer motion blur have poor pixel information, and this may 

confuse PhotoScan and become a factor in the failure of photogrammetric modeling. To 

avoid this failure, poor quality images have to be removed beforehand by using image 

quality estimation in PhotoScan. To use this detection, the Photos Pane is opened after 

images are uploaded (Views > Panes), and then the display mode must be changed to the 

Details view. After selecting all photos, the Estimate Image Quality command is shown 

by right clicking on selected images. This command estimates the sharpness of images 

and calculates crispness as quality. When the process is completed, images may be re-

organized based on quality by clicking on the Quality tab (Fig. 3-40). Then images that 

have quality below a certain threshold value should be removed.  Unfortunately each 

photo must be opened and checked carefully, because the calculated value of quality and 

sharpness also depends on image size. As a starting threshold value, the author has found 

that rejecting images below a quality value of 0.45 produces satisfactory model results 

captured from video frame images.  Employing this procedure allows photogrammetric 

modeling using video frames to proceed without poor quality images. 
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Figure 3-40. Process for removing blurred images in PhotoScan. (Image: Yamafune) 

 

 

 Video Frame Photogrammetry has both advantages and disadvantages. Two 

major advantages are wider coverage areas and better image overlapping. Since video 

recording does not require careful camera positioning, it tends to have much larger 

coverage areas than photo-shooting.  During the Gnalić 2014 field season, one diver 

recording the site with video could cover an area four times larger than a diver shooting 

photographs in the same amount of time (Fig. 3-41 and 3-42). Another advantage is 

better image overlapping. Because one second of video footage is composed of 24 to 30 

still images, the overlapping of consecutive images is marvelous. Therefore, Video 

Frame Photogrammetry tends to have excellent results in the Align Photos process. 

Balancing these advantages are the disadvantages of lower image resolution and fewer 

original colors. Lower image resolution often results in poor quality textures in the Built 
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Texture process. This is because most high-definition (HD) resolution video footage 

only has 1920 x 1080 pixels per frame, while a photo from a DSLR camera (with an 

ACL-S sensor) contains approximately 6000 x 4000 pixels.  Thus, a frame captured from 

HD video camera footage contains less than 10% of the pixel information of the 

equivalent photo taken by a DLSR camera.  Another disadvantage is less original color.  

As discussed in chapter II, auxiliary lighting can preserve the original colors of subjects; 

however, underwater environments require strong auxiliary lighting sources to penetrate 

water. This strong lighting can easily be obtained by employing strobe lights while 

taking photographs; however, it is nearly impossible to apply strong lighting as effective 

as strobe flashes while video recording. Even if a video camera has strobe lights that can 

provide auxiliary lighting, the power obtained from continuous spot-lighting is not 

strong enough in terms of original color retrieval. Consequently, photogrammetric 

models developed via Video Frame Photogrammetry tend to have a bluish-tone (Also 

see Fig. 3-41 and 3-42).  
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Figure 3-41. Video Frame Photogrammetry of the Gnalić shipwreck site. Photogrammetric models based 

on video footage have a much larger coverage area than photogrammetric models based on photos. 

However, without strong auxiliary lighting, created models tend to have bluish and greenish colored 

textures. (Image: Yamafune) 

 

 

 
Figure 3-42. Computer Vision Photogrammetry of the Gnalić shipwreck site.  The coverage area of 

photogrammetric models is limited because of the nature of photo-shooting. However, created models tend 

to contain more detailed and diagnostic archaeological information due to their use of high-resolution 

images. Also, thanks to the use of strobe lights, created models can display more original colors. (Image: 

Yamafune) 
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In short, Video Frame Photogrammetry can be a good option for 

photogrammetric recording, especially when a project does not have DSLR cameras or is 

time-constrained when performing photogrammetry. Nonetheless, the most important 

point is that whoever applies Video Frame Photogrammetry must understand both the 

advantages and disadvantages of using video footage as the source for photogrammetry. 

 

Underwater Video Frame Photogrammetry Using GoPro 

As described above, Video Frame Photogrammetry is beneficial in many ways, 

especially for novice underwater photographers and divers who do not have knowledge 

of photogrammetry. One reason is that it does not require complicated camera and strobe 

lights settings.  Additionally, less expensive cameras with good High Definition (HD) 

underwater video recording capability are becoming commercially available.  

Among these cheaper camera options, the most popular product today is likely 

the GoPro series. GoPro cameras have HD video recording systems that are very easy to 

handle in water, though their fish-eye lenses create distortion on captured images. 

However, using the Adobe Photoshop series (CS6, CS5, and CC), distortion in frames 

captured from GoPro video footage can be easily corrected. Not only does Photoshop 

have image correction tools, it additionally has the processing ability to automatically 

extract still frames from video footage at a specified frequency. Also, Photoshop allows 

color and haze correction over the entire video clip before still frames are extracted.  In 

the end, satisfactory photogrammetric models can be created using GoPro cameras.  
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The following steps are a recommended workflow for Video Frame 

Photogrammetry using GoPro. The original GoPro video footage used for concept 

validation was taken by Charles Bendig, a graduate student at the University of West 

Florida. The videos were recorded by a GoPro Hero 3. The total duration of the video 

was 2 minutes and 15 seconds and frame dimension was 1280 x 960 pixels. In this 

workflow, Adobe Photoshop CS6 was used. To begin, the view window of Photoshop 

was shifted to Motion workspace, then the video footage was imported (Window > 

Workspace > Motion > Add Media). Next, the video clips were trimmed to the desirable 

proportions to be used for Video Frame Photogrammetry. Before applying distortion and 

color correcting processes, each video clip had to be converted to a Smart Object (Filter 

> Convert for Smart Filters) for image editing. Then, the “Lens Correction filter and 

Unsharp Mask filters were applied to the video clips in order to correct distortions and to 

sharpen video images. After these two filters were applied to the video clips, adjustment 

layers were applied to enhance the quality of the video clips; these adjustment layers 

were Curves, Levels, Color Balance, and Vibrance. Curves adjustment enhances the 

contrast in an image while Levels adjustment enhances color-distributions of the image. 

Color Balance adjustment restores original colors by reducing greenish and bluish tones 

in the water, and the Vibrance adjustment enhances the natural colors of the subjects in 

the images (Fig. 3-43 and 3-44).  After satisfactory results were acquired with these 

corrections, still frames were extracted from video clips using the Render Video 

command. With this command, the number of extracted frames (per second) can be 
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controlled (File > Export > Render Video > Photoshop Image Sequence > Frame Rate: 

number of frames per second).  

 

 
Figure 3-43. The original GoPro video footage before the color and distortion correction (Image: 

Yamafune) 

 

 

 
Figure 3-44. GoPro video footage after the color and distortion correction (Image: Yamafune) 
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After those images were prepared, the extracted frames were uploaded to 

PhotoScan as photo images. However, as noted earlier, these frames were automatically 

extracted from the video clips in Photoshop and were not selected carefully with 

photogrammetry in mind. Consequently, some images were subject to motion blur. 

Therefore, bad quality photos needed to be excluded before photogrammetric modeling 

could begin. To do so, the Estimate Image Quality command was applied (on Photo 

Pane, change view mode to Details views > select all cameras > right click on selected 

cameras > “Estimate Image Quality); low quality images were noted and disabled. Then, 

once the Align Photos process was started, all of the following photogrammetric 

processes were identical to the PhotoScans basic workflow for Computer Vision 

Photogrammetry. In addition to Photoshop there are many other open source software 

packages that can extract still frames from video footage, such as Free Video to JPG 

Converter. However, to retrieve original colors and correct distortion, the use of 

Photoshop or a similar image editing or video editing software is recommended. Figure 

3-45 displays the photogrammetric model with the pre-processed image corrections in 

Photoshop and Figure 3-46 shows one without any image corrections (Fig. 3-45 and 3-

46).    
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Figure 3-45. Photogrammetric model based on video footage with color and distortion corrections applied 

in Photoshop. (Image: Yamafune) 

 

 

 
Figure 3-46. Photogrammetric model based on video footage with color and distortion corrections applied 

in Photoshop. (Image: Yamafune) 
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Georeferenced Orthophotos 

One of the prominent features of PhotoScan is its ability to produce orthophotos. 

Orthophotos are high-resolution photomosaics, and PhotoScan can compose them based 

on calculated camera positions. Orthophotos are more accurate than traditional 

photomosaics because they do not have optical distortion. Moreover, when an 

orthophoto is created of a scale-constrained model, the exported orthophoto will also 

have correct proportions. PhotoScan also has an ability to create GeoTIFF images; this 

file format contains georeferenced information. This image is also 1:1 scale. GeoTIFF 

orthophotos are very useful, especially when archaeologists need to create a 

photomosaic for a larger area, such as an entire shipwreck site. When archaeologists 

have to create detailed photogrammetric models, the photo coverage area may be 

limited. This situation can be caused by constrained diving time on the area, the number 

of photos needed to capture the entire area, or the limited computing power of available 

computers. The author suggests that when a photogrammetric model of the whole 

archaeological site needs to be created, it is easier to focus on small areas and piece the 

separated parts together later. When a model of a shipwreck site is created in separate 

batches, it is impossible to produce one complete orthophoto of the entire site from 

separated models (though it may be possible if the project computer has substantial 

computing power and graphic cards to create one complete 3D model of larger coverage 

area, for instance 100m x 25m shipwreck sites), yet this is less likely on most 

archaeological projects because of budgetary constraints. However, as long as the 

photogrammetric model’s scale is based on local coordinate systems as the author 
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explained in Chapter II, exported orthophotos can contain georeferenced information. As 

briefly mentioned above, GeoTIFF orthophotos have georeferenced data; in other words, 

the image is a 1:1 scale of the actual shipwreck site and images can open in correct scale 

and position in GIS software. Consequently, even if orthophotos of the archaeological 

site were created in separate areas or on different dates, they will merge automatically 

based on georeferenced information. The method used to create GeoTIFF orthophotos is 

simple. First, the model must have georeferenced data, such as markers with XYZ 

coordinates. Then, within the Export Orthophoto command in PhotoScan, a checkbox 

that says GeoTIFF will appear in the exported orthophoto window. If it is selected, the 

exported TIFF image contains georeferenced information. 

Four different orthophotos in GeoTIFF format were created during the Gnalić 

Project’s 2014 field season. These orthophotos were exported to ArcGIS mapping and 

spatial analysis software. Once there, the orthophotos opened automatically in the 

correct positions and with the correct scale; therefore, no manual adjustment was 

required (Fig. 3-47).  Since orthophotos have 1:1 exact scale and have no optical 

distortion, exported orthophotos are tremendously useful for archaeological analysis; 

orthophotos can be used as templates for the creation of conventional 2D site plans and 

special analysis. 
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Figure 3-47. Composed Orthophotos of the Gnalić shipwreck site from the 2014 field season. As the final 

result, four orthophotos were produced from different data. These georeferenced orthophotos were merged 

automatically in ArcGIS software. (Image: Yamafune and Torres) 

 

 

Even without georeferenced information, exporting normal orthophotos is useful. 

When a GeoTIFF orthophoto is created, the projection plane must be a top view. 

Although the exported orthophoto will not be at 1:1 scale, the projection plane of an 

ungeoreferenced orthophoto can vary. In other words, it can be a photomosaic of a top 

view, side view, front view, and so on (Fig. 3-48). Additionally, if the rotation of a 

photogrammetric model is controlled before the orthophoto is created, an orthophoto that 

is parallel to the archaeological site can be created. This orthophoto based on a parallel 

projection plane may be useful when the archaeological site lies on a sloped seabed 

(Also see Fig. 3-48. The red plane refers to a projection plane that is parallel to the 

shipwreck site). Actual usage of orthophotos shall be discussed in following sections. 

Scale of exported ungeoreferenced orthophotos can be corrected in CAD software and 

Photoshop to match the desired scale. Therefore, archaeologists can choose to create a 

georeferenced orthophoto or a non-georeferenced orthophoto depending on their needs.  
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Figure 3-48. Image of the visualized projection planes of orthophotos. The projection plane can be chosen 
from six different orthogonal directions. Moreover, by controlling the rotation of the photogrammetric 

model, the projection plane can be made parallel to the archaeological site (the red layer). (Image: 

Yamafune) 

 

 

GIS Based Spatial Data Archive  

Once the information and photos from the excavation are organized and stored in 

the database, work can proceed (see Chapter II). Now, using georeferenced orthophotos, 

archaeologists can merge their manually collected information with the georeferenced 

information to create a database that can be used for spatial analysis. Spatial analysis of 

a shipwreck site is vital for understanding the original shapes of the ship; Dr. George 

Bass and Dr. Frederick Van Doornick, and their research team reconstructed the 

hypothetical original shape of the seventh-century Yasssi Ada shipwreck based on 

meticulously recorded positions of artifacts even though actual wooden remains of hull 

structure were sparse (Van Doorninck, 1967; Bass, 1972; Bass and Van Doorninck, 
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1982). During the Gnalić  2014 project, Dr. Torres, a ShipLab research associate (and 

Texas A&M University Ph.D candidate at the time) was in charge of GIS analysis, 

organizing the database, and the production of 2D site plans. He used ArcGIS mapping 

software for those tasks. The author is currently learning his skills first hand. 

Henceforth, the following discussions are based on Dr. Torres idea of using 

archaeological data from the excavation team to perform spatial analysis based on 

georeferenced orthophotos.  

During the Gnalić Project 2014 field season, Dr. Torres introduced ArcGIS 

mapping software to the excavation team. ArcGIS is a mapping and spatial analysis 

software. During the project, georeferenced orthophotos created by the author were 

imported into ArcGIS. Because of the georeferenced information, orthophotos created in 

PhotoScan opened in the correct global position. Additionally, orthophotos that were 

created on different dates and in different areas automatically georeferenced and 

produced a completed one-piece orthophoto that encompassed the entire archaeological 

site. What is more, information about the site’s artifacts, photos of the artifacts, and 

sketches and annotations by archaeologists were connected to ArcGIS. Therefore, all the 

information that was collected by the excavation team was linked to georeferenced 

spatial information. Henceforth, orthophotos and artifacts can be linked and used for 

spatial analysis, such as understanding cargo distribution and site formation processes. 

Also, ArcGIS and other basic GIS software packages have basic drawing 

capability. Therefore, archaeologists can trace imported orthophotos to produce 2D site 

plans (Fig. 3-49). Dr. Torres periodically produced 2D site plans and printed out partial 
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plans on mylars; therefore, archaeologists and divers could bring these site plans on their 

dives and use them as templates upon which they could add additional information. 

After the field season, Dr. Torres produced a 2D site plan in ArcGIS based on imported 

orthophotos (Fig. 3-50). 

 

 

 
Figure 3-49. The Gnalić shipwreck site in ArcGIS software. All corrected data by the excavation team is 

connected to georeferenced orthophotos. (Image: Reprinted with permission from Torres, 2014b) 
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Figure 3-50. 2D site plan of the Gnalić shipwreck based on the 2014 field season. This 2D site plan was 

produced in ArcGIS mapping software. (Image: Reprinted with permission from Torres, 2014c) 

 

 

2D Site Plan and Timber Catalog Templates 

In the previous section, the author described a method for creating a conventional 

2D site plan using ArcGIS software. Drawing in ArcGIS allows each image to have 

georeferenced information. Also, 2D site plans can be created in other CAD softwares, 

such as the AutoCAD series and Rhinoceros series, and in drawing software, such as the 

Adobe Photoshop series and Adobe Illustrator series. Some archaeologists may prefer to 

print scaled orthophotos on paper and trace them manually. In short, there are various 

ways to produce site plans using orthophotos, and archaeologists can choose a method 

based upon available software and personal preference. However, these methods are all 
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based on tracing orthophotos of archaeological sites. This tracing method is 

tremendously quick and easy in comparison to conventional drawing methods that are 

based on archaeologist’s sketches and collected measurements. Nonetheless, based on 

the author’s experience, these tracing methods are not fast enough to follow the ongoing 

excavation weekly. Indeed, the first production of a 2D site plan is often completed only 

after the field season is over. Therefore, during a field season, briefings and debriefings 

for the project proceed using orthophotos or site plans from the previous season. Yet, 

these orthophotos are often visually too noisy to understand the structure of site, and 

manually tracing it (either on paper or in a computer program) to create a 2D site plan 

takes time. After attending six archaeological excavations, including three years on the 

Gnalić Project, the author began seeking faster and easier methods for creating 2D site 

plans that could be used for planning the logistics of an ongoing project and help 

archaeologists understand the excavation as it unfolds. Based on these ideas, the author 

found what he calls the erasing method. 

 

Erasing Instead of Tracing Method 

Although tracing an orthophoto to create a 2D site plan is a substantially faster 

and more accurate method than the conventional manual hand drawing method used by 

archaeologists, it still requires knowledge of software and sometimes knowledge of 

shipbuilding. Therefore, production of 2D site plans are often done by experienced 

archaeologists. However, in many cases those experienced archaeologists are occupied 

by other tasks during the field project, and this is one of the main reasons that production 
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of a 2D site plan must to wait until the field project is over. The author believes that if 

the production of a 2D site plan does not require special skills and knowledge, this task 

can be assigned to attending students and divers. Yet, the process must be easy and fast 

enough to follow the ongoing project. To satisfy those needs, the author developed an 

erasing method. 

The concept of the erasing method is simple; the archaeologist erases the internal 

parts of timbers on the orthophoto and the product is converted into a sketch-like 

drawing using Photoshop. Erasing, or cleaning, can enhance the edges of structures. The 

first converting part of the process (described below) requires special knowledge of the 

software; however, once it is converted, the rest of the process requires only the erasing 

tool. Since this erasing method requires only a single tool in Photoshop, it can be done 

by any team member. The process begins with the conversion of an image into a sketch-

like drawing. To determine the best way to create the sketch-like drawing, the author 

attempted various methods that can be found in training books and videos, and so far the 

best result was acquired from a method that was found on YouTube (Ch-Ch-Check It, 

2011). In the following section, the author explains a slightly modified method of this 

conversion process using the orthophoto of the Gnalić shipwreck site from the 2014 field 

season. 

First, the composite orthophoto was exported from ArcGIS and opened in 

Photoshop CS6 (Fig. 3-51). When an image is opened in Photoshop, the original layer is 

opened as a locked layer called Background. This locked layer has to be unlocked to be 

an editable layer (Layer > New > Layer from Background). Now this layer (layer 0) can 
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be duplicated (Layer > Duplicate Layer), and then it needs to be converted into a black 

and white image (Image > Adjustments > Desaturate). The author recommends that one 

change the layers name to B&W to avoid confusion (Layer >Rename Layer). Next, this 

B&W layer must be duplicated again, and then the duplicated layer should be Inverted 

(Image > Adjustments > Invert). The author also recommends that you rename this 

inverted layer to Inverted. Then, the blending mode of this layer must be changed from 

Normal to Color Dodge. Although, this may create the appearance of a plain white 

image, that is fine. The next step is to extract edges from the original orthophotos. To do 

so, the Gaussian Blur filter must to be applied to the Inverted layer (Filter > Blur > 

Gaussian Blur). By this point, the edges of the original orthophoto can be enhanced as a 

black and white image. The next step is to extract more detailed edges. To extract 

detailed edges, the B&W layer must be duplicated again (Layer > Duplicate Layer), and 

the duplicated layer must be moved to the top of the layer panel. Then, the Glowing 

Edges filter must be applied on the B&W layer (Filter > Filter Gallery > Stylize > 

Glowing Edges). At this point, the author also changed the layer’s name to Glowing 

Edges (Layer > Rename Layer). After the Glowing Edges layer is inverted (Image > 

Adjustments > Invert), the blending mode of this layer must be changed from Normal to 

Multiply. After these steps are applied, the orthophoto of the site plan is converted into a 

sketch-like drawing (Fig. 3-52). After these layers are flattened to a single layer (Layer > 

Merge Layers), it is time to utilize the erasing method. 
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Figure 3-51. Orthophoto of the Gnalić shipwreck site from 2014 field season. (Image: Reprinted with 

permission from Torres, 2014d) 

 

 

 
Figure 3-52. Sketch-like conversion of the otrhophoto of the Gnalić site. (Image: Yamafune) 
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This sketch-like conversion is already visually appealing and can be used as a 

figure for publication; yet the author aims to create a cleaner and more stylized 2D site 

plan. Once the orthophoto has been converted to a sketch-like drawing, the following 

step is surprisingly easy; it only requires an erasing tool that can be found in the tool bar 

on the left side of the Photoshop screen. The diameter of the erasing tool can be 

controlled. For example, it took only two hours for the author to clean the structures of 

the Gnalić shipwreck (Fig. 5-53). This means that a 2D site plan can be acquired within 

a day. Another advantage of this erasing method using Photoshop is that any mistakes 

can be corrected afterward (by keeping original images behind the working layer). 

Additionally, since these images are computer based, they can be updated at any time. 

Therefore, these images can be printed on Mylar using a laser printer so that 

archaeologists and divers can dive with these site plans as a template upon which the 

positions of scarves and fasteners can be drawn. These 2D site plans can be reimported 

into ArcGIS and additional information can be uploaded. It can then become part of the 

database. Based on his experiences, the author believes that this erasing method is much 

faster than the tracing method and it does not require any skills or knowledge of software 

once the orthophoto is converted to a sketch-like image. This method could be very 

useful during field projects.  
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Figure 3-53. Proposed 2D site plan created with the erasing method. The internal depictions of structure 

were cleaned by the erasing tool in Photoshop. (Image: Yamafune) 

 

 

Timber Drawing Templates (with Automated Masking) 

The author discussed the sketch-like conversion technique in the previous 

section. This technique is tremendously useful for timber drawings as well. One of the 

unique and important tasks of nautical archaeologists is recording timbers. Because ship 

timbers may contain tool marks and fasteners, the timbers contain important information 

for archaeologists that sheds light on the construction and design of the original ships 

(Fig. 3-54). Knowing the dimensions of the timbers is necessary when reconstructing the 

shape of the original ship. However, waterlogged wood may warp and deteriorate as 

soon as it is removed from the underwater site. Therefore, archaeologists must record the 
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timbers as precisely as possible, yet as quickly as possible. However, this timber 

drawing also requires a great deal of experience and training to do properly. 

 

 

 
Figure 3-54. An Example of conventional timber drawing (from Cais do Sodre shipwreck) made by an 

archaeologist (Castro, Yamafune, Eginton, and Derryberry, 2011). (Drawing: Castro, 2011) 

 

 

 During the Gnalić Project 2014 field season, several timbers were raised, and the 

conservation laboratory team attempted to produce timber drawings. This attempt was an 

exercise for university students and was supervised by an experienced historian. 

However, for most of the students, the drawing training was their first experience with 

timber recording. As a result, only three timbers were recorded in two weeks by two 

students.  
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Because of this difficulty, the author realized the importance of a quick and 

accurate method for creating templates for timber drawings. Fortunately, the author had 

an opportunity to create a photogrammetric model of one of the raised timbers. This 

timber was named T99. After the photogrammetric model was created, the model was 

re-scaled using a scale bar tool in PhotoScan. Six orthophotos were created based on six 

different projection planes of orthogonal directions; then, those orthophotos were aligned 

in Photoshop and converted to sketch-like images (Fig. 3-55). As a result, a template of a 

timber catalog for T99 was created in four hours. Archaeologists can add tool marks and 

nail holes on this template based on their observations, which speeds up the recording 

process. 

 

 

 
Figure 3-55. An example of a timber drawing template. (Image: Yamafune) 
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A key to the successful photogrammetric modeling of this timber was the 

automated masking technique applied in Photoshop. The masking technique for 

Computer Vision Photogrammetry is often used in PhotoScan. Masking is a technique 

that hides pixel information in assigned regions. Hiding unnecessary regions in images 

facilitates the photo alignment process. Therefore, it is useful when turntables are used to 

capture a subject because the background remains the same in photos, which facilitates 

masking. The masking feature is also useful when archaeologists want to capture all 

aspects of an artifact’s different sides because an artifact can be rotated and masking can 

hide the background. Although PhotoScan has various ways of creating masks in the 

software, the author believes that the best results can be acquired by using Photoshop for 

masking before importing the images into PhotoScan for processing. Photoshop has very 

precisely controlled selection tools and the selected area can be saved as an alpha 

channel (transparency pixel data) with TIFF image formats. What is more, using Action 

commands, this masking process can be automated. The author shall explain the 

automatic masking method using Photoshop in the following section.  

To apply automated masking, photos have to be taken under controlled 

conditions. This masking process uses a selection tool in Photoshop; therefore, a 

monotone background is required. Green screens used by the motion picture industry are 

based on the same masking idea. For T99 from the Gnalić shipwreck, a white sheet was 

used as the background. Theoretically speaking, any monotone colored background can 

be used as long as it is a different color than the subject. Once photos of all sides of the 

artifact are taken, the photos are transferred and stored in a temporary folder. One photo 
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must be opened in Photoshop to create an Action command. If the Action command 

window is hidden from the workspace, it can be reopened from Window menu (Window 

> Action). After the Record command of the Action command is activated, the masking 

process must be applied to the image. To mask an image with a monotone background, 

the best selection tool is the Magic Wand. The background must be selected by clicking 

on a corner of the image. After confirming that all of the background is selected except 

the subject, this selection area should be inverted (Selection > Invert). Once selection is 

inverted so that only the subject is selected, the selection area can be saved as an alpha 

channel. To do so, select Save as a channel option under the Channels tab, which is 

located next to the Layers tab. The image now has alpha channel information. Then the 

image must be saved in the TIFF file format because JPEG cannot carry alpha channel 

data. When the image is saved as a TIFF file and closed, the recording of the Action 

command also must be stopped to complete recording. By taking these steps, it is 

possible to create an action command that can create masks in Photoshop. What is more, 

Photoshop can apply an action command on a collection of photos that are stored in one 

folder (File > Automate > Butch, or File> Automate > Create Droplet). Using this Batch 

Action command, masking can be automatically applied to hundreds or thousands of 

photos simultaneously. After the TIFF images are uploaded to PhotoScan, the masks 

should be applied to the images again (Tools > Import > Masks > From alpha) (Fig. 3-

56). This masking technique is tremendously useful and fast. Also, this method of 

automated masking can be applied to any photogrammetric modeling project as long as 
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the photos are taken in a controlled environment. Moreover, since unnecessary pixel 

information is hidden from the modeling process, processing time is shortened. 

 

 

 
Figure 3-56. Computer Vision Photogrammetry with masked photos. Masked images can be seen in the 

photo pane on the bottom (the black part of photos were masked).  Precise masking improves the quality 

of photogrammetric models. (Image: Yamafune) 

 

 

 Using this automated masking technique, the photogrammetric model of T99 

was created showing all sides of the timber. By association, the timber drawing 

templates also showed all sides of the timber. One or two timber drawing templates can 

be produced within a day, after which, archaeologists only need to add fastening and tool 

marks to the template. This template system substantially accelerates the timber 

recording process.  
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The author believes that this timber drawing template method has great potential 

because archaeologists will only need a quick photo shoot session with the timber to 

gain a large amount of information. The timber will only need to be removed from the 

site for 15 to 30 minutes. In other word, as long as the team has a monotone board or 

sheet on the boat, divers can raise timbers onboard the dive boat temporarily and return 

them to the underwater site after photos are taken. The rest of the process can be done 

without timbers, and archaeologists can add tool marks and fastenings using photos and 

photogrammetric models. This methodology makes it unnecessary for archaeological 

projects to acquire a budget for conservation and storage, which is often difficult. For 

these reasons, the author encourages the use of this method to create timber drawing 

templates for quick and accurate recording.  

Before closing this discussion, the author wants to mention that this method of 

producing timber templates can be used for artifact drawings as well. In addition to the 

visually appealing drawing and quickness of production, one of the important factors of 

this method is its accuracy of dimension and details. The author converted orthophotos 

of a port tiller block from the Red River Wreck Heroine (1832) into a sketch-like artifact 

drawing. From photo shooting to the drawing’s completion, the process takes only three 

hours (Fig. 3-57). The author must note that within these three hours a 1:1 scale 

photogrammetric model is also created along with the orthophotos. 
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Figure 3-57. Artifact drawing of a port tiller block found in Red River Wreck site based on exported 
orthophotos. (Image: Yamafune) 

 

 

Section Profiles of Shipwreck Sites 

Section profiles of the shipwreck site are valuable because they may represent 

hull lines of the original ship before it sank. One of the most important pieces of 

information that archaeologists must acquire from the shipwreck site is the curvature of 

the ship’s frames. Since 1960, when archaeologists began to dive to underwater 

shipwreck sites, many manual methods have been used to extract the curvatures of 

frames (Steffy, 1994; Bowens, 2009). It is tremendously difficult and requires a great 

deal of training to measure and draw the correct curvatures of frames. Because of this, 

many frames have been raised and traced by archaeologists on land in order to record the 
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curvatures. However, raising frames to record them is time consuming and labor 

intensive. Additionally, as a result of the 2001 UNESCO Convention on the Underwater 

Cultural Heritage, the importance of in situ preservation has become recognized. 

Consequently, acquiring the curvature of frames from underwater shipwreck sites has 

become more difficult than ever.  

Fortunately, thanks to Computer Vision Photogrammetry, archaeologists are 

capable of creating real scale photogrammetric models of underwater shipwreck sites. 

Since properly created photogrammetric models contain correct measurements, 

archaeologists can acquire the curvature of frames from photogrammetric models. 

However, when the author first tried to acquire curvature and section profiles of the 

Gnalić shipwreck site in 2013, he encountered a problem in the form of heavy data; to 

extract curvature of the correct locations (at frame positions) unnecessary meshes have 

to be deleted to clear the desired area. This manipulation takes a lot of computing power, 

and desired rendered images were difficult to obtain because it is difficult to control the 

precise location and image scales of the camera in PhotoScan. After experiencing these 

difficulties, the author found a way to acquire section profiles of shipwreck sites without 

altering the original meshes of the photogrammetric models. This method is facilitated 

by Autodesk Maya’s unique camera features. During the Gnalić Project 2013 and 2014 

field seasons, the author experimentally applied this method to extract section profiles of 

selected exposed frames on the shipwreck site (Fig. 3-58 and 3-59).  In the following 

section, the author discusses the methodology of section profile extraction that can be 

accomplished without disturbing the original photogrammetric models.        
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Figure 3-58. 2D site plan of the Gnalić shipwreck from 2013 filed season with positions of the cross 

sections. (Image: Reprinted with permission from Castro, 2014b) 
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Figure 3-59. Transversal section profiles of the Gnalić shipwreck site from 2013 and 2014 combined 

photogrammetric models. (Image: Yamafune) 

 

 

Exporting Photogrammetric Models to Autodesk Maya 

The key to this extraction methodology is the camera settings in Autodesk Maya 

(the author used the 2012 and 2015 versions of Maya for this section profile extraction). 
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To open photogrammetric models in Maya, it is important to export the file in the correct 

format. Three exports file formats that are available (April 2015) in PhotoScan that are 

compatible between PhotoScan and Maya: these are wavefront OBJ (.obj), COLLADA 

(.dae), and Autodesk FBX (.fbx) file formats. The author strongly recommends OBJ file 

format. There are several reasons for this recommendation. The first reason is that OBJ 

is the most commonly used 3D modeling file format, so that exported data can be used in 

most of the other 3D modeling softwares when needed. The second reason is that the 

COLLADA and FBX formats are occasionally not recognized correctly by Maya. For 

these reasons, the author always uses the OBJ format when exchanging files between 

PhotoScan and Maya. However, there are several important points that must be 

remembered during the data exchanges. The first is that, when the exporting log is 

opened in PhotoScan (File > Export Models), the exporting coordinate system must be 

matched with the one that is currently in use for georeferenced information (Reference 

pane > Settings tab > Coordinate System). For instance, when XYZ coordinates were 

input on markers on photogrammetric models using the WGS 84 world coordinate 

projection system, dialog in export models should be set to be WGS 84 coordinate 

projection system in order to give the models correct georeferenced information. The 

second point is that Maya doesn’t work well with file names that have spaces between 

characters. For instance, sometimes Maya cannot correctly recognize files that have 

spaced names, such as 03 21 Barrel. To avoid this problem, the file name must be 

03_21_Barrel or 0321Barrel. Thirdly, XYZ axis orientation in Maya is different from the 

coodinates in PhotoScan. Therefore, once a photogrammetric model is imported to 
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Maya, it must be rotated -90 degrees on the X-axis. Fourthly, the tone of the imported 

model may be too bright; therefore, the imported model’s Ambient Light on Material 

Node in Attribute Editor must be corrected manually using Attribute Editor. Also, when 

photogrammetric models were exported as an OBJ files, PhotoScan also creates an .mtl 

file along with the OBJ file. This .mtl file designates paths between the exported model 

and its textures. In other words, without .mtl files, paths between meshes and 

corresponding UV maps for the texture will be broken; therefore exported OBJ files 

must always be stored together with corresponding .mtl files. Finally, after exported files 

are organized in Maya’s pipeline directories (also called a projects window files), 

sometimes links between meshes and textures may be broken (especially when one uses 

PhotoScan and Maya in different computers). Accordingly, textures must be re-assigned 

manually using the Color Nodes option on the material tabs on Attribute Editor. By 

following these steps correctly, exported photogrammetric models will be ready to be 

used in Maya (Fig. 3-60).  
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Figure 3-60. Imported saveiro’s photogrammetric model in Maya. The screenshot shows orthographic 

viewports (top, front, side, and perspective views), and Attribute Editor on the right. (Image: Yamafune) 

 

 

Creating CT Scan Cameras in Maya 

The main advantage of using Maya for section profile extraction is that Maya 

software has the ability to convert its default view port cameras into customized view 

port cameras which functions similar to medical CT scanner (Computed Tomography 

scanner/Computerized Axial Tomography scanner) cameras in order to see thin-sliced 

cross sections of objects, like the human body, or in this case, a shipwreck. Though 

Maya is not intended to be used for this purpose, there is a way to customize Maya’s 

default view port camera settings to make them into proper CT scan view port cameras. 

Technically speaking, the CT scan view port cameras are not created from a new 

camera, rather they are customized from the default side or the front view port cameras 

of the orthographic view windows. Although new cameras can be created inside Maya 
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(besides the default orthographic view port cameras), but these new cameras show views 

in perspective; this means that objects located close to the viewer are shown larger, and 

objects located far from the viewer are shown smaller (same as human eyes). Therefore, 

the best way to show objects in correct ratio and scale without optical distortion is to use 

default orthographic view port cameras that display sheer projections of top, front, and 

side views. These three default view port cameras show objects in correct scale whether 

or not an object is located near or far from the camera; in other words, these cameras 

don’t have any optical distortion. Nonetheless, these default orthographical view port 

cameras are not visible and their position and rotation cannot be controlled. To make 

these cameras visible and to be able to manipulate them, the author uses Image Plane 

(View (on side or front view pane) > Image Plane). Once a view plane is created, the 

camera with an orthographical view becomes visible. However, the created view plane 

can be visually distracting; therefore, it must be hidden by increasing transparency using 

Alpha Gain on Image Plane Attribute (Select Image Plane >ImagePlaneShape tab on 

Attribute Editor > Alpha Gain on Image Plane Attributes).  

Once the side or front view port cameras are visible, these cameras are ready to 

be customized to be CT scan view port cameras. Maya is a modeling software, and its 

viewport cameras have a function that hides objects from view port windows if the 

object is located outside of the designated distance of the view port camera settings. For 

instance, this function is used when a car is being modeled inside a town with many 3D 

models of buildings; while the car is being modeled, buildings and other objects behind 

the car should not be displayed in the view port because it makes the view port window 
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extremely busy. Therefore, visible distance from the camera can be controlled with the 

settings Near Clip Plane and Far Clip Plane (Select a desired camera > sideShape (or 

frontShape if you chose the front camera) on Attribute Editor > Near Clip Place and Far 

Clip Plane). For instance, when the values of Near Clip Plane is customized as 0.001 and 

Far Clip Plane as 1.5 for the saveiro’s imported photogrammetric model, a camera only 

displays a mesh that is 1.5cm from the camera (Fig. 3-61). Also this camera’s position 

and rotation can be changed to display desired areas. In short, the 3D model is sliced 

without disturbing any of the mesh properties. Since this camera has a function that is 

similar to medical CT scanners, the author calls it a CT scan camera. Also, rendered 

images of section profiles can be organized in Photoshop afterwards for reconstructions 

and publications; in order to make the organization and alignment of the captured images 

easier, the author recommends creating guiding objects around the photogrammetric 

model. For the saveiro’s photogrammetric model, the author placed six long cubic 

objects on the model that are 30cm apart horizontally and 20cm apart vertically (also see 

Fig 3-61). 
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Figure 3-61. Extracting a section profile from the photogrammetric model of the saveiro wooden model in 

Maya. The side orthographic camera (bottom right viewport) has been customized as a CT scan-like 

camera. Also six guiding objects are created around the imported photogrammetric model. These cubes are 
positioned at calculated distances, which will help the captured images be correctly aligned and scaled 

afterword (Image: Yamafune). 

 

 

A total of 12 section profiles were extracted from the saveiro’s photogrammetric 

models (Fig. 3-62 and 3-63). This time, section profiles between floors and futtocks 

were taken. However, any values of visible distance from the camera and precise 

locations of camera can be manipulated; therefore, on a large shipwreck site, the 

individual curvature of a timber can be taken using this method. 
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Figure 3-62. Approximate positions of extracted section profiles. (Image: Yamafune) 

 

 

 
Figure 3-63. Section profiles of the saveiro’s photogrammetric model. The twelve captured section 

profiles are aligned in Photoshop. (Image: Yamafune) 
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Conclusion: Section Profiles 

The curvature of frames on a shipwreck site is one of the most valuable pieces of 

information that can be used to understand a sunken ship. However, to measure the 

curvature of frames under water requires good diving skills and extensive experience. 

The curvatures can be obtained easily once a frame is removed from the shipwreck site; 

however, removing frames from shipwreck sites is labor intensive and destructive in 

terms of conservation and preservation. Because of this, the author believes that the 

previously discussed extraction methodology is tremendously useful because once a real 

scale photogrammetric model is created and imported to Maya, section profiles of any 

position on the shipwreck site can be obtained quickly and accurately. Similar to the 

process of acquiring measurements using scale bars in PhotoScan, extraction of 

curvature can be accomplished without visiting the shipwreck site. The author believes 

that this curvature extraction methodology is valuable on any excavation or survey of 

shipwreck sites. Nevertheless, without proper analysis and usage of these extracted 

section profiles, this extraction methodology is useless. Accordingly, in the first part of 

Chapter IV, the author discusses reconstruction of the original ship’s shape using section 

profiles extracted from the saveiro photogrammetric model. 
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CHAPTER IV 

DATA ANALYSIS 

 

Data Analysis: Legacy of J. Richard Steffy 

After processing the archaeological data (including section profiles, 2D site 

plans, timber drawings, spatially organized archaeologist’s sketches, pictures of the 

shipwreck site in GIS software, and 1:1 scaled photogrammetric models), archaeologists 

should begin analyzing the processed data. At this point, methodologies for analyzing 

and reconstructing shipwrecks are very similar to methodologies that nautical 

archaeologists have been applying to this discipline for decades. The guidelines for 

reconstructing hull lines and analyzing shipwrecks were first introduced to this discipline 

by J. Richard Steffy, one of the founders of nautical archaeology. The author studied the 

history of wooden shipbuilding in the J. Richard Steffy Ship Reconstruction Laboratory 

at Texas A&M University (ShipLab) and learned his reconstruction methods from Dr. 

Luis Filipe Viera de Castro, current director of the ShipLab. With this background, the 

author composed this proposed methodology using both the new technology to record 

shipwreck sites and the conventional methods for reconstructing shipwrecks that nautical 

archaeologists have used since 1960s.  

 

Hull Line Reconstruction 

Once section profiles have been extracted from a shipwreck site, the next step in 

understanding the shipwreck is to reconstruct the ship’s hull lines. Hull lines represent 
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the tridimensional shape of a ship. They can indicate the capacity of the ship, as well as 

its sailing ability and stability (Fig. 4-1, 4-2, and 4-3).  

 

 

 
Figure 4-1. Illustration of water displacement calculation based on hull lines. Water displacement can 

reveal the capacity of a ship (Image: Yamafune)  

 

 

 
Figure 4-2. Illustration of the block coefficient. The block coefficient indicates the breadth of a ship. 

(Image: Yamafune) 
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Figure 4-3. Illustration of the prismatic coefficient. The prismatic coefficient can provide a rough estimate 
of a ship’s speed. (Image: Yamafune) 

 

 

Consequently, when hull lines are reconstructed, archaeologists can understand 

not only the original shape of the hull, but other characteristics of the ship as well 

(Steffy, 1994: 253-255). The author learned the methods of ship reconstruction during 

his graduate studies and also from experience gained while creating the reconstruction of 

the Cais do Sodrés hull lines (Castro, Yamafune, Eginton, and Derryberry, 2011) (Fig. 

4-4).  

 

 

 
Figure 4-4. Reconstruction of the hull lines of the Cais do Sodré shipwreck. The lines were reconstructed 

based on timber drawings and total station data. The drawing was done by hand in the summer of 2010. 

(Image: Yamafune) 
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This method for reconstructing hull lines is similar to what Steffy described in his 

paper about the reconstruction of the Serçe Limanı shipwreck. Steffy reconstructed the 

Serçe Limanı shipwreck first using a 1:10 scaled reconstructed diorama of the shipwreck 

site and its timbers. He reconstructed these fragmented timber models based on tangency 

of frame curves, shapes of frame joineries, positions of fasteners, tool marks, and so on 

(Steffy, 1982). To utilize Steffy’s hull reconstruction methodology combined with his 

own methodology for recovering data, the author used extracted section profiles (see 

Chapter III) for the reconstruction of hull lines. 

For the reconstruction of hull lines, the author used section profiles that were 

produced from the photogrammetric model of the saveiro wooden ship model. To 

recompose the curvatures of the frames, Rhinoceros 3D CAD drawing/modeling 

software was used. The author often prefers to use CAD drawing/modeling software 

over hand drawing because its various drawing tools and object snapping modes allow 

quick and precise drawings. More importantly, the computer-based drawings can be 

easily converted to 3D surface models and exported to other modeling and analysis 

software to obtain mathematical data. To begin, the image of section profiles that was 

extracted from the 1:1 scaled photogrammetric model was imported to Rhinoceros. 

Then, section profiles were traced and re-oriented based on tangency of curvatures of the 

floor timber and futtocks (Fig. 4-5).  Tracing and re-orienting was applied to all the 

section profiles in order to reconstruct a body plan of the saveiro wooden ship model 

(Fig. 4-6). After all of the sections lines were reconstructed, these sections can be plotted 

into the correct locations (Fig. 4-7).  
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Figure 4-5. The process of reconstructing section lines based on the saveiro photogrammetric model. 

(Image: Yamafune) 

 

 

 
Figure 4-6. The reconstructed twelve master frames of the saveiro wooden ship model based on the 

photogrammetric model and archaeological data. (Image: Yamafune) 
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Figure 4-7. Plotted section lines of the saveiro wooden ship model. Reconstructed section lines are placed 
based on frame positions. (Image: Yamafune) 

 

 

In actual archaeological projects, the hull lines reconstruction is not complete 

until all water lines and section lines are perfectly fair. More importantly, these hull lines 

reconstructions are largely dependent on the positions of fasteners and joineries. In 

addition, the position of curves relies upon construction marks and other ship structure 

components, such as stringers, keelson, beams, knees, and so on. All of this information 

gives more precise pictures of the ship, including the hull lines. This is the reason that 

the author has repeatedly remarked in this dissertation that underwater sketches and any 

other information must be collected manually by archaeologists along with producing 

photogrammetric data, and all data must be stored in a georeferenced database, such as a 

GIS-based mapping software. Reconstruction of hull lines must be based on collective 

information. Yet, the author emphasizes the advantages of the methodology of using 

section profiles of photogrammetric models to reconstruct hull lines because 
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archaeologists can produce hull lines even without removing and conserving the frames.   

 

Mold-and-Batten Model Fairing 

The final step that must be applied to this reconstruction procedure before 

finalizing the reconstruction of the section hull lines is the Mold-and-Batten Model 

Fairing. The Mold-and-Batten model was originally suggested by Steffy as an initial 

analysis process of ship reconstruction (1994: 221-224). This method uses molds and 

battens to analyze fairness of the reconstructed structure (Fig. 4-8). This system is 

similar to how diagonal lines are used to check fairness when drafting 2D hull lines 

drawings. 

 

 

 
Figure 4-8. Mold-and-Batten Model reconstruction by J. R. Steffy. (1994: 222) 
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The author applied this process on the reconstructed section lines using 

Rhinoceros 3D CAD drawing/modeling software. Rhino is recommended on Mold-and-

Batten Model Fairing because it uses NURBS spline curves. Several diagonal lines that 

pass section lines were added in order to check its fairness. When the diagonal lines are 

not fair, reconstructed section lines, or angles of floor timbers and futtocks, should be 

adjusted using each curve’s editing points until the diagonal lines shows fair lines (Fig. 

4-9). This Mold-and-Batten Model Fairing converts reconstructed section lines into 

section profiles of watercraft; therefore, this step should be applied during the course of 

ship reconstruction. 

 

 



 

133 

 

 
Figure 4-9. Mold-and-Batten Model Fairing in Rhinoceros 3D CAD software. Dark blue and green lines 

on the left are reconstructed section lines before the adjustment; light green and blue lines on the right are 

adjusted section lines. Yellow lines are diagonal lines, or simulated battens, before adjustment, and red 

lines are adjusted diagonal lines. (Image: Yamafune) 

 

 

Testing Author’s Hull Line Reconstruction 

The author chose the saveiro wooden ship model for this dissertation’s hull line 

reconstruction because the reconstructed hull lines can be tested. The saveiro is a 

traditional boat type that is still being used today in Bahia, Brazil. The design the saveiro 

was inherited from a type of ship that was used by the Portuguese during the Age of 
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European Expansion during the 16th and 17th centuries (Sarsfield, 1984; Sarsfield 

1985a; Sarsfield, 1985b; Sarsfield, 1991; Castro and Gomes-Dias, 2015). In the 16th and 

17th centuries, Portuguese and Spanish shipwrights designed their ships based on simple 

geometry and ratios of main components of the ship. For instance, the dimensions of 

many important components of the ship were based on a ratio related to the keel length 

and breadth at the midship frame (maximum breadth) (Oliveira, 1995; Sarsfield, 1984; 

Sarsfield, 1985a; Castro 2005a, Castro 2007; Castro, 2008; Castro and Gomes-Dias, 

2015). Dr. Castro, the current director of the J. Richard Steffy Ship Reconstruction 

Laboratory (ShipLab), is very interested in the saveiro’s design, and he has acquired 

original shapes of half molds from his visits to saveiro shipwrights in Bahia (Fig. 4-10). 

Dr. Castro also received several graminho from the shipwrights. A graminho is a piece 

of timber that is used for determining the rising and narrowing of pre-designed master 

frames. The virtue of the Iberian design of ships during the Age of European Expansion 

and the design of saveiro boats today is that the shapes of predesigned master frames 

were determined by simple geometry that is controlled by three simple timbers: a mold 

for the floors, a mold for the futtocks, and a graminho for the narrowing and rising 

(Sarsfield, 1984; Sarsfield 1985a; Sarsfield, 1985b; Sarsfield, 1991; Castro and Gomes-

Dias, 2015).  



 

135 

 

 
Figure 4-10. A traced and scaled sketch of a saveiro’s molds by Dr. Castro. These molds are used for stern 

knees, transoms, floors, futtocks, and stems (described from the top). (Image: Reprinted with permission 

from Castro, 2015) 

 

 

The author also studied these designs and methods in the ShipLab. Using half 

molds and a graminho that was used for the saveiro wooden model, the author was able 

to determine the originally intended complete shape of the master frames. This 

completed original design of the saveiro wooden model was compared to the 

reconstructed shape that was based on the photogrammetric model (Fig 4-11). 



 

136 

 

 
Figure 4-11. The process of designing pre-made master frames of the saveiro wooden ship model. Designs 

were done using three pieces of wood: a mold of the floors, a mold of the futtocks, and a graminho to 

determine the rising and narrowing of the frames. (Image: Yamafune) 

 

 

After the design of the master frames of the saveiro wooden ship model was 

completed, the author compared them with the reconstructed hull lines of the saveiro 

wooden ship model that was created based on section profiles extracted from the 

photogrammetric model. Figure 4-12 displays the original design in red and the 

reconstructed hull lines in blue (Fig. 4-12). The author believes that the reconstruction of 

the hull lines based on photogrammetric data is successful; the blue lines were drawn 
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exclusively based on photogrammetric data, or archaeological information, yet the basic 

dimension of the two lines are very close, especially the curvatures of the floor timbers.  

 

 

 
Figure 4-12. Comparison of the reconstructed hull lines based on photogrammetric data and the original 

design of saveiro wooden ship model. The blue lines show the section lines of the reconstructed hull lines 

of the wooden model, and the red lines show the original design of the wooden model based on its molds 

and graminho. (Image: Yamafune) 

 

 

Nonetheless, this experiment suggests something very important. The 

comparison indicates that the greatest misfit between the two sets of lines appears at the 

extremities of the futtocks. This is because of the fact that when the author was setting 

up the simulated archaeological site of the saveiro wooden ship model for Computer 

Vision Photogrammetry, the author placed the futtocks on the ground randomly based on 

relative distance from the edges of the connecting floor timbers. Therefore, while 

reconstructing hull lines based on extracted section profiles, the correct positioning of 

the curvatures of futtocks relating to locations of floor timbers was difficult. Aside from 
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the simulated archaeological site of the saveiro wooden ship model that the author used 

for the hull lines reconstruction, actual archaeological shipwreck sites contain joineries 

and fasteners in the frame timbers. This information is tremendously important for the 

reconstruction of hull lines. Computer Vision Photogrammetry is able to capture detailed 

textures and accurate dimensions of shipwreck sites, yet these are still not as accurate as 

trained archaeologist’s eyes. This information must be collected by archaeologists on the 

shipwreck site or recorded with timber drawings so that it can be used for hull line 

reconstruction or data analysis. This experiment confirmed the importance of traditional 

recording methods. Again, the author must note that new technologies, including 

Computer Vision Photogrammetry and other software, can improve archaeologist’s 

studies and research, but its effective use relies upon complementary use of traditional 

methods employed by archaeologists. 

 

Archival Research and Shipwreck Analysis 

As a result of the data acquisition processes previously discussed, the author 

believes that nautical archaeologists should have enough processed data to begin 

analyzing the context of the shipwreck site. However, nautical archaeologists cannot 

fully understand a shipwreck without understanding the historical background, the 

period of shipbuilding, and findings from other contemporary shipwrecks. Archaeology 

is the discipline of uncovering the human past using material culture. History is the 

discipline that analyzes the human past based on written accounts. Of course both 

disciplines often interact with each other; however, the author believes that nautical 
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archaeology benefits greatly when scholars can utilize both material culture and written 

record (where available). In this dissertation, the author has discussed only 

methodologies applied to archaeological excavations. However, it must be noted that 

archival research both before and after a field season is immensely helpful to 

understanding the archaeological record. 

For nautical archaeology, archival research can vary. Important types of archival 

research include the identification of shipwrecks and their cargo, finding shipwrights’ 

treatises and iconography of similar ship types, and studying the construction of other 

contemporary shipwrecks. Historical information and archaeological data acquired in the 

field can be used to help analyze hull structures and shipwreck sites. 

 

Hull Analysis 

Hull analysis is used to understand ship construction and shipbuilding methods. 

Prior to the invention of aircraft, boats and ships were the only way people could cross 

water without having to swim. Watercraft remains provide us a window on thousands of 

years of human seafaring activity and all that it encompasses: technological 

developments, trade, warfare, and other types of cultural interactions. 

There are a variety of methodologies used to analyze shipwreck sites for 

information about shipbuilding. How an archaeologist reconstructs a ship is largely 

based on acquired data, and how the ship is interpreted also depends on the ship’s known 

purpose and its time period. Beyond this point, it is impossible to generalize study 

methods for hull analysis. However, as an example of a way to analyze shipbuilding 
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techniques based upon data provided by shipwrecks, the author proposes the Interactive 

Fragment Model method in the following section. 

 

Interactive Fragment Model 

When J. Richard Steffy studied the Serçe Limanı shipwreck, an 11th-century 

A.D. Mediterranean vessel, he carefully recorded fragmented timbers and their locations. 

First, he created a 1:10 scale diorama of the shipwreck site, and then he moved the 

fragmented pieces back into their hypothetical original position (Steffy, 1982). Steffy 

called this the Fragment Model. Then, based on the positions of tool marks and timber 

fasteners, he revealed his theory about the construction method used to build the Serçe 

Limanı ship. This was critical information that helped all nautical archaeologists 

understand the transition of shipbuilding from shell first construction to frame first 

construction. The author has studied Steffy’s method and modified it into the Interactive 

Fragment Model. 

The Interactive Fragment Model is identical to the Fragment Model method in 

that it attempts to bring the shipwreck structures back to their original position. Based on 

the positions of structures, including fasteners and joinery, nautical archaeologists can 

understand the patterns of shipbuilding. The difference between the Interactive Fragment 

Model and the Fragment Model is that the author uses a 1:1 scale photogrammetric 

model instead of a 1:10 scale diorama model. In addition, the author uses Deformation (a 

method of manipulating the shape and geometry of the model without disturbing its 

original entity) to reconstruct the photogrammetric models using Maya instead of 
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manual reconstruction of a wooden models. Consequently, the Interactive Fragment 

Model is a much faster and more reversible method than the Fragment Model method. 

The author conducted experiments to determine how the Interactive Fragment 

Model can be used to learn more about a shipwreck site. For this purpose, the author 

required a 3D reconstructed model of a ship (created from hull lines) and a 

photogrammetric model. Due to circumstance and available information, and because an 

archaeologist often doesn’t have an intact version of the ship that is being excavated, the 

author used a different ship for the 3D reconstructed model (the Pepper Wreck) and the 

photogrammetric model (the Gnalić shipwreck). For the purpose of exploring the usage 

of the Interactive Fragment Model, the author created a reconstructed model of the 

Pepper Wreck using the ship’s hull lines. The Pepper Wreck was an early 17th century 

Portuguese East Indiaman Nossa Senhora dos Martires. Based on historical 

documentation, the ship was 30 m long at the keel with an overall length of 40 m. Dr. 

Castro studied and reconstructed this shipwreck based on historical documents and 

archaeological data. (Castro, 2003; Castro, 2005a; Castro, 2005b; Castro 2007).  The 

author reconstructed the Pepper Wreck tridimensionally using Autodesk Maya and 

information based on Dr. Castro’s research (Fig. 4-13 and 4-14).  
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Figure 4-13. An image of the hull of the Pepper Wreck being reconstructed in Maya based on Dr. Castro’s 
lines drawing. (Image: Yamafune) 

 

 

 
Figure 4-14. A 3D reconstruction of the Pepper Wreck based on historical and archaeological data. 

(Image: Yamafune) 
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Based on archival research conducted by Mauro Bondioli, the Gnalić Shipwreck 

was a Venetian merchant ship named Gagliana grossa with a 30 m length at the keel and 

40 m length overall. The ship sank off the coast of Croatia in 1583, about two decades 

earlier than the Pepper Wreck (Radić Rossi et al., 2013). Despite the fact that the ship 

was constructed in a different region using different ship building methods, both ships 

were of similar size and usage (they were round-bottomed cargo-carrying merchant 

ships), and operated in the same era. For these reasons, the author decided to combine 

the 3D reconstructed model of the Pepper Wreck with the photogrammetric model of the 

Gnalić shipwreck site to explore how the Interactive Fragment Model can be used to 

reveal more information about the Gnalić shipwreck site. The relatively comparable 

Pepper Wreck is being used to shed light on the Gnalić shipwreck. 

The Interactive Fragment Model requires modeling and animation software. The 

author used Maya. The key factor of this method is a computer function called 

Deformation, a digital method of manipulating a 3D model. When a 3D model needs to 

be animated, animators put digital skeletons inside created models and bind meshes of 

the 3D models to skeletons as skin. Therefore, the 3D models can be animated based on 

the position of the skeleton (Fig. 4-15).  
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Figure 4-15. Illustration of 3D model Deformation. A rigid 3D model can change its form based on 

assigned skeletons and rigs. (Image: Yamafune) 

 

 

When the skeleton moves, the vertices of the meshes follow their assigned 

skeleton. This alters the shape of the meshes, which is why the process is called 

Deformation. For the Interactive Fragment Model, the author prepared a simple skeleton 

for the shipwreck site. Most archaeological shipwreck sites are severely flattened. They 

must be brought back to their original shapes to enhance their diagnostic components in 

order to understand the shipbuilding techniques used to build the original vessel.  The 

author used deformation to bring shipwreck sites back into their hypothetical original 

shape. Once these skeletons were placed in the photogrammetric model, their meshes are 

bound to the skeleton (Fig. 4-16). As a result, the shipwreck site is now able to change 

its shape based on the position and rotation of the skeleton (Fig. 4-17). Then, the author 

imported a 3D model of the Pepper Wreck and juxtaposed it against the Gnalić wreck so 

that the Gnalić wreck was in its hypothetical position in the ship’s hull (Fig. 4-18). Most 
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likely, when a 1:1 scale photogrammetric model of a shipwreck site is placed on a 

hypothetically reconstructed ship model, it will not fit perfectly because the ship 

structures have been flattened (particularly when two different ships are being used, 

though the process still reveals valuable information as long as the ships are similar 

enough) (Fig. 4-19). Therefore, the author deformed the photogrammetric model of the 

Gnalić shipwreck structure until it fit with the reconstructed ship model (Fig. 4-20). 

Once a photogrammetric model is brought back to roughly the original shape of the ship, 

many components of the shipwreck site become more diagnostic. For instance, the 

storage pattern of the barrels on the Gnalić shipwreck became clear after the Interactive 

Fragment Model was applied, even though it was an experiment using different ships’ 

data (Fig. 4-21).  

 

 

 
Figure 4-16. Photogrammetric model of the Gnalić shipwreck structures in situ overlaid with the Skeleton 

tool in Maya. (Image: Yamafune) 
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Figure 4-17. Deformation of the Gnalić shipwreck site in Maya. Meshes of 3D models change their shape 

based on the shape of the skeleton. (Image: Yamafune) 

 

 

 
Figure 4-18. Photogrammetric model of the Gnalić shipwreck site and reconstructed 3D ship model in 

position. (Image: Yamafune) 
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Figure 4-19. Flattened Gnalić shipwreck site juxtaposed with hypothetical reconstructed ship model. 

(Image: Yamafune) 

 

 

 
Figure 4-20. The Gnalić Shipwreck site brought back to the hypothetical original shape using the 

Interactive Fragment Model. (Image: Yamafune) 
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Figure 4-21. Storage pattern of the barrels on Interactive Fragment Model of the Gnalić shipwreck site. 

Diagnostic context became clearer thanks to the Interactive Fragment Model method. (Image: Yamafune) 

 

 

In this dissertation, the author avoids further analysis of the Gnalić shipwreck site 

using this method because the reconstructed model used for comparison is from a 

different shipwreck. The method revealed valuable information about the barrels, but 

any further analysis would be unreliable. Yet for real archaeological projects, nautical 

archaeologists must reconstruct the hull lines of the shipwreck once enough frame 

timbers are exposed and recorded. Hull lines can also be reconstructed based on 

historical documents that are found during archival research.  

Before closing this section, the author would like to remark on one more point; 

for the experimental Interactive Fragment Model method that was just discussed, the 

author used the reconstructed 3D model of the Pepper Wreck. However, this application 

can be used with hull lines instead of 3D models. With proper interpretation, 

contemporary shipwrights’ treatises and 2D reconstructed hull lines drawn by scholars 

can be converted into 3D hull lines (Fig. 4-22). These 3D lines can be stored in a data 
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archive so that nautical archaeologists can apply the Interactive Fragment Model method 

immediately after a photogrammetric model of the shipwreck site is produced. This can 

be used as a tool to identify the type of ship. In short, the Interactive Fragment Model is 

very flexible and can be used for a variety of analysis purpose. J. Richard Steffy noted 

that generating a wooden Fragment Model is a very time consuming and labor intensive 

method; however, using new technologies, nautical archaeologists can apply his method 

in very quickly and in a less labor intensive manner. 

 

 

 
Figure 4-22. A reconstructed set of hull lines based on shipwrights’ treatises. The figure displays the 

digital reconstruction of the Deane’s 3rd-rate British ship (Deane and Lavery, 1981). Whenever a 

shipwreck with a similar type is found, this 3D hull line is ready to be used with the Interactive Fragment 

Model. (Image: Yamafune) 

 

 

Site Analysis 

Site Analysis includes the study of the site formation processes that occurred 

during the wrecking event and those that have occurred in the years since. 

Photogrammetric models can assist the archaeologist in understanding the layout of both 
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the ship and the artifacts on the site, which can provide clues about the site formation 

process. However, site analysis should not be limited to the study of what happened to 

the shipwreck in the past and what is happening in the present. The proper analysis of a 

shipwreck site must encompass what could happen to the wreck in the future and 

develop a management plan to deal with this. However, this only becomes possible when 

the archaeologists have a clear understanding of the wreck site and comparisons of other 

shipwreck sites based on several seasons of site recording and monitoring. Here, the 

author proposes a site monitoring method based on Cloud Compare, a point cloud 

analysis software. 

 

Photogrammetry Based Site Monitoring 

One of criticisms that underwater archaeologists often receive from terrestrial 

archaeologists is that underwater archaeology does not match the site recording 

standards that terrestrial archaeology follows.  This is true to some extent.  In land 

archaeology, archaeologists record layers of sediment and their contents. This is called 

the study of stratigraphy and it is possible because of the nature of terrestrial sites. At the 

end of a terrestrial field season, the archaeology team may have sequential layers of site 

plans that help them understand stratigraphy and the site formation processes that have 

occurred on the site. Contrarily, nautical archaeologists may not try to produce layers of 

site plans because working time underwater is limited. On some sites, archaeologists can 

only work on the site for less than one hour per day (for example, when the 

archaeological site is more than 30 m deep). In addition, running underwater excavations 
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is tremendously expensive because excavation require special equipment, including a 

diving boat. Therefore, until present day (2015), nautical archaeologists are usually able 

to create only one site plan at the end of the field season. In short, it has been nearly 

impossible for nautical archaeologists to produce layers of a site plan to help understand 

stratigraphy and site formation processes.  

However, several years ago, PhotoScan, a fairly inexpensive and accurate 

photogrammetry software appeared on the market. Nautical archaeologists realized the 

importance of its data producing ability. Today, using the correct methods with 

photogrammetry software and other computer programs, nautical archaeologists can 

produce archaeological site plans fairly quickly. With this ability comes a clearer 

understanding of the site formation processes that act upon archaeological sites. 

Additionally, this clear understanding may help provide accurate predictions of what 

could happen to the archaeological sites in the future, which can help archaeologists 

develop reliable preservation and monitoring plans. There are several computer analysis 

software programs that archaeologists can use to analyze data that was produced during 

Computer Vision Photogrammetry. The author will briefly introduce this analysis 

software, which is called CloudCompare. It can be used to support archaeological site 

analysis and facilitate site monitoring.  

CloudCompare is an open source 3D point cloud analysis software. PhotoScan 

can export dense point clouds in a variety of file formats. Some of the file formats are 

compatible between PhotoScan and CloudCompare, such as the ASTM E57 file format 

(.e57) and ASPRS LAS file format (.las). If the photogrammetric model is 
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georeferenced, the point cloud also automatically contains geographical information, 

thus, exported point clouds will open in the correct location with the correct scale. The 

main ability of CloudCompare is deviation analysis; in other words, it can compare two 

different point clouds and visualize the differences using colors (Fig. 4-23).  

 

 

 
Figure 4-23. Visualizing the progression of the Gnalić 2014 excavation using CloudCompare. The 

photogrammetric point clouds show the area on the shipwreck where barrels were found. (Image: 

Yamafune) 

 

 

Using this point analysis software, archeologists can track the progression of the 

excavation, both short term and long term. Moreover, this can help archaeologists track 

the accumulation of sediments and other alterations that occur on archaeological sites 

through the years. This can assist with making predictions about the near-future 
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conditions of the site in terms of in situ preservation. Furthermore, those deviation 

analysis can be used to monitor long-term condition of both excavated and unexcavated 

sites. To conclude, using 3D data produced by Computer Vision Photogrammetry and 

deviation analysis software, nautical archaeologists can track the progression of 

excavations in order to understand shipwreck sites both in the past and in the future. 

 

3D Reconstructions 

Before the workflow completes its final step, which is publication, the author 

would like to suggest one additional step between hull analysis and publication, which is 

3D reconstruction. The author believes that 3D reconstruction is a great way to test a 

scholar’s hypotheses about a shipwreck. 3D reconstructions can be created in a variety 

of ways. Building a scaled wooden model is a common and traditional method often 

utilized by nautical archaeologists; some projects even build 1:1 scale operational 

reconstructed ships. 3D printing is becoming popular as well. In the following section, 

the author briefly discusses creating 3D reconstructions using 3D computer modeling 

software. The author often receives questions from colleagues about which computer 

modeling software they should start learning. For this reason, the author will briefly 

discuss two different types of 3D computer modeling methods that nautical 

archaeologists can use to build 3D reconstructions that can be used to test their 

hypotheses. 
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NURBS Modeling and Polygon Modeling 

Non-Uniform Rational B-Splines [NURBS] modeling and Polygon modeling are 

two different approaches to computer modeling. The idea behind NURBS modeling is 

that one can create surfaces based on curves, or wireframes. These curves are shaped 

based on mathematical formulas, which can create very smooth and accurately measured 

models. Polygon modeling is based on creating surfaces made of polygons that often 

have triangular and quadrilateral surfaces. Meshes of photogrammetric models are also 

categorized as Polygon models. These faces can be manipulated by vertices and edges. 

Both NURBS modeling and Polygon modeling have advantages and 

disadvantages. The biggest advantage of the NURBS system is its precision and 

accuracy. This is the reason that many industrial CAD drawing and modeling software 

programs use the NURBS system. The AutoCAD series and Rhinoceros series are two 

examples. For nautical archaeology, NURBS modeling has advantages in modeling ship 

hulls because they are designed using curves (Fig. 4-24). NURBS modeling allows 

archaeologists to draw or trace curves and create surfaces based on these curves; 

therefore, NURBS modeling is suitable for when archaeologists need to reconstruct their 

hypothesis based on measurements and precise dimensions (Fig. 4-25). The 

disadvantage of the NURBS system is that texture mappings are not available on 

NURBS models. Only the simplest pattern can be used for textures on NURBS models.  
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Figure 4-24. A 3D model of a ship’s hull as an example of NURBS modeling. Using NURBS modeling, 

users can model smooth curvatures and surfaces (Image: Yamafune) 

 

 

 
Figure 4-25. 3D reconstruction of a boiler from the shipwreck of the Westfield steamship created by Justin 
Parkoff. The author assisted by creating a 3D model based on Parkoff’s reconstruction measurements for a 

museum installation. Therefore, this 3D model is entirely based on precise measurements. (Image: 

Yamafune) 
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The biggest advantage of Polygon modeling is its easy manipulation; the shape of 

objects can be changed while maintaining closed solid model properties. Additionally, 

we can apply and position textures using UV mapping (2D atlas, or canvas, for textures 

to be projected), which makes detailed and controlled texturing possible. The 

disadvantage of Polygon modeling is that the dimensions of models become arbitrary 

once you change the basic shape. Polygon models are not mathematically controlled in 

the way that NURBS models are; therefore, dimension and details of models based on 

archaeological data may lose their precision once the model is changed. Nevertheless, its 

ease of manipulating model shapes makes Polygon modeling more suitable for 3D 

reconstructions when the model is created using site plans and photogrammetric models 

as data. Using this technique, the site plans or photogrammetric models are traced to 

create the 3D reconstruction. Modeling by tracing is tremendously easier with Polygon 

modeling than it is with the NURBS system (Fig. 4-26). Therefore, when modeling does 

not require exact precision over accuracy in terms of the dimensions of 3D models, the 

author strongly recommends Polygon modeling (Fig. 4-27). Fortunately, many modeling 

softwares, including Maya, can convert NURBS models into Polygon models; therefore, 

nautical archaeologists can create a ship’s hull using NURBS curves initially, and then 

convert it to a Polygon model to assign visually appealing textures if necessary. 
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Figure 4-26. 3D model of Stella 1 shipwreck as an example of Polygon modeling. The model was created 
by tracing site plans. The original site plan of the shipwreck was drawn by Dr. Castro (Capulli and Castro, 

2012). (Image: Yamafune) 

 

 

 
Figure 4-27. Hypothetical reconstruction of an early 17th century rigging arrangement of a Portuguese 

East Indiaman as an example of Polygon modeling. This 3D model was created based on historical 

accounts as well as descriptions and iconography about rigging of contemporary ships (Castro, 2003; 

Castro, 2005b; Castro, 2009; Castro, Fonseca, and Wells, 2010). This information did not indicate exact 

measurements of the rigging components. Therefore, Polygon modeling is an easier and better choice than 

NURBS modeling in this case. (Image: Yamafune) 
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To conclude this section, archaeologists must choose either NURBS modeling or 

Polygon modeling when creating a 3D model reconstruction to test their hypothesis. The 

important factor in this decision must be based on the goals of the reconstruction and the 

methods by which the original data was obtained. In short, when a model will be 

reconstructed based on the curvature of hull lines or based on precise measurements that 

archaeologists must follow, the author strongly recommends NURBS modeling 

software, such as the Rhinoceros series; on the other hand, when modeling must be done 

based on historical description and iconography, or based on tracing archaeological site 

plans and photogrammetric models, the author strongly recommends Polygon modeling 

software, such as the Maya series.   

 

 

 

 

 

 

 

 

 

 

 

 



 

159 

 

CHAPTER V 

PUBLIC OUTREACH & PUBLICATION 

 

Visual Tour Animation 

In this chapter, the author will discuss various ways of sharing archaeological 

research with the public, which is a vital and ethically necessary part of archaeology. 

The first public outreach methodology that the author would like to introduce is Visual 

Tour Animation, which is a simple animation that uses photogrammetric models and a 

flying camera created in Autodesk Maya (this animation can be done in other modeling 

and animation softwares such as Blender). The author believes that making a Visual 

Tour Animation is much simpler and easier than creating conventional computer 

generated animations because it does not require computer modeling and Deformation. 

Since most of the modeling for the Visual Tour Animation can be done with Computer 

Vision Photogrammetry software, the required knowledge of computer animation in 

Maya is Key-Frame Animation for a created flying camera. The basic concept of 

computer generated animation is the same as that of video recording; one second of 

animation is composed of 24 – 30 rendered images so that the human eye and a brain see 

it as a movie instead of consecutive pictures. When the Animation Setting in Maya is set 

at 24fps (frames per second), a 20 second animation has 480 still frame images. Key 

frame animation uses these frames as keys of timing (designated timing of actions of the 

object, such as positions, scales, and rotations of the selected object). When the position 

of a cube needs to be moved from point A to point B in 20 seconds, the first default key 
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frame would be frame 1 and a cube would be located at point A. Then, the Set Key 

command is applied by pressing the S button. This command orders the cube to be 

located at point A at key frame 1. Then, the current frame on the Time Slider Tab that 

can be seen at the bottom of the Maya workspace needs to move from 1 to 480 to make 

time flow in Maya 20 seconds later (24 fps x 20 seconds). Also, the position of the cube 

must be moved to point B, and then the Set Key frame command should be applied. 

Consequently, the cube travel from point A to point B in 20 seconds (Fig. 5-1). 

 

 

 
Figure 5-1. An example of simple key frame animation. Keys of the cube are set on frame 1 and 480. As a 

result, the cube traveled between two assigned positions from A to B in 20 seconds. (Image: Yamafune) 

 

 

Transparency of the material can also be animated so that the visibility of the 

objects can be easily controlled. Using transparency, objects can fade in and fade out in 

the animation (Select object or material > material node tab on Attribute Editor > 

Transparency > Set key by right click on Transparency). This fade-in and fade-out 
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animation allows archaeologists to show the progress of the excavation to the general 

public (Fig. 5-2). 

 

 

 
Figure 5-2. Key frame animation of transparency of the materials. The photogrammetric model can fade in 

and fade out using this technique. (Image: Yamafune) 

 

 

To create a Visual Tour, archaeologists need to animate a camera in Maya. A 

camera in Maya is not a camera in the traditional sense. It is a way to render specific 

images from a digital camera that flies around the site (Fig. 5-3). In Maya, new cameras 

can be created (Create > Cameras > Camera and Aim) and will render images through 

their viewports (From Rendering work space > Render > Butch Render).  
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Figure 5-3. A created flying camera in Maya. The position of the camera and its aim can be key-animated. 

Visual Tour Animation can be created through this flying camera’s viewport. (Image: Yamafune) 

 

 

Though rendering settings can vary, the only important settings that 

archaeologists need to know to create a Visual Tour Animation can be found under the 

Common tab in Rendering Settings. These commands are File Output, Frame Range, 

Renderable Cameras, and Image Sizes (Window > Rendering Editors > Rendering 

Settings). The Butch Render command exports still images created by the viewport of 

the flying camera. Although Maya can export relatively low resolution movies by 

choosing AVI file format output in the Render setting, high resolution still images that 

were exported though the Butch Renderings process are not yet a movie. The images still 

need to be pieced together to become an animation. The author uses Adobe Premiere Pro 

CS6 to compose animations because this video editing software also allows composed 

animations to have visually appealing titles, scene transitions, and various sounds. To 

compose a movie from still images in Premiere Pro is simple. Once the desired still 
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images have been selected in the Import window (File > Import), the Image Sequence 

box at the bottom needs to be checked (Fig. 5-4). Then, the imported selected images 

will automatically be uploaded as video footage. After titles and other video transition 

effects are added to the animation, Premiere Pro can export the animation in the desired 

file format such as MP4 (H.264), AVI, or QuickTime (File > Export > Media). Then, the 

visual tour animation is ready to be shared. 

 

 

 
Figure 5-4. Converting still images to an animation using Image Sequence import in Adobe Premiere Pro 

CS6. (Image: Yamafune) 

 

 

The author believes that Visual Tour Animation is a an excellent method for 

sharing our discoveries and excitement with the general public because not many people 

are able to visit the sites, either because they cannot SCUBA dive or because they lack 

the permission required to visit many underwater shipwreck sites. It is particularly useful 
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for when an excavation is ongoing. Furthermore, poor visibility on the shipwreck site 

often prohibits good video camera footage from being obtained. However, computer 

generated animations can deliver clearer images of the entire archaeological site. Using 

the transparency key frame animation, the Visual Tour Animation can show the progress 

of an excavation.  

From the archaeologist’s perspective, this proposed method does not require any 

special knowledge of computer modeling or deformation beyond the skills needed to 

create the original photogrammetric models that are used for archaeological analysis. 

The animations can be created within a day or two. This means that visual tour 

animations of the shipwreck’s site can be uploaded to the Internet for public viewing on 

a weekly basis without taking too much time away from archaeological research. 

Consequently, the public can not only see results of the season but can also follow the 

progress of excavation. The author created several animations from the 2013 and 2014 

Gnalić Project field seasons and received many positive comments from the public as 

well as from archaeologists. 

 

Interactive Virtual Museum 

Another outreach method that can be created using photogrammetric models is an 

Interactive Virtual Museum. The Visual Tour Animation is a passive way to share 

archaeological information with the general public; on the other hand, the Interactive 

Virtual Museum is an active way to do so. One of the benefits of Computer Vision 

Photogrammetry is its visually appealing 3D models. PhotoScan can export these models 
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in various file formats, including PDF files. Any computer with an installed PDF reader 

is able to rotate PDF files, which essentially makes the image on the PDF a 3D model 

that can be zoomed and rotated by viewers.  

There are also webpages that will host 3D models. The webpages, such 

www.Sketchfab.com [Sketchfab], can be used by anyone and shared without any special 

software. The author believes that the trend of uploading and sharing 3D models will 

become more popular. For example, the author uses Sketchfab. PhotoScan also supports 

this webpage officially so that created photogrammetric models can be directly uploaded 

to Sketchfab (File > Upload models > Sketchfab).  Also, Sketchfab can host a variety of 

file formats. The author has often exported photogrammetric models into Autodesk 

Maya to fix problems or to combine several photogrammetric models. Then, completed 

models are exported in OBJ file format and uploaded to Sketchfab. Many of the 3D 

model-sharing webpages allow uploaded 3D models to have annotations and 

explanations of the models. Viewers can rotate and zoom models by themselves and 

enjoy 3D models more interactively (Fig. 5-5).  
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Figure 5-5. Photogrammetric model of the Gnalić shipwreck site in Sketchfab. Users can interactively 

control the position of the camera, or a viewpoint. Also, its annotations can display information related to 

the models. (Image: Yamafune) 

 

 

Using these 3D model-sharing webpages, such as Sketchfab, archaeologists can 

share our field experiences with the public more easily and quickly without creating an 

animation using programs such as Maya. Because webpages like Sketchfab don’t require 

any special knowledge or software experience, the Interactive Virtual Museum is an 

easier method than creating a Visual Tour Animation. Using this method, the public can 

follow ongoing underwater archaeology projects via these webpages. For these reasons, 

the author believes that using the 3D model sharing webpages to support an Interactive 

Virtual Museum is a very effective method for sharing photogrammetric models with the 

public. 
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Publications 

The final step of the proposed workflow is publication. Since many shipwreck 

sites are located in underwater environments, it is very difficult for other scholars and 

the public to have access to archaeological sites. Thus, in many cases, archaeological 

publications are the only way that other people can access technical information about 

the shipwrecks. It is very clear why it is vital that all archaeological projects reach the 

publication phase. Forms of publication can vary; museum exhibitions, newspaper 

articles, and project webpages can be forms of publication. Yet in this dissertation, the 

author also wants to note another possible perspective on publishing in peer reviewed 

journals and scholarly books.  

Throughout this dissertation, the author has discussed ways to combine Computer 

Vision Photogrammetry with traditional research methods for nautical archaeology. The 

point of this discussion was to replicate real scale shipwreck sites in digital format so 

that archaeological information could be extracted from the models. The author also 

believes that 1:1 scale constrained photogrammetric models can contribute greatly to 

scholarly publications such as peer-reviewed journals.  Before explaining how Computer 

Vision Photogrammetry can contribute to these publications, the author would like to 

note why he came up with his ideas regarding publication. The author always had 

questions about the publication of underwater archaeology. Peer reviewed journal 

articles of natural science have protocols that describe the procedures used in their 

experiments and research. Therefore, everybody who reads the journal can replicate the 

experiment that journal article described. In other words, description and research results 
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of natural science are repeatable and testable. Contrarily, in the field of social science, it 

is tremendously difficult (if not impossible) to replicate and test the results that are 

described in publications. The reason for this is very obvious in the field of underwater 

archaeology because of the difficulty of accessing the underwater sites. However, as the 

author described in the Interactive Visual Museum section, sharing 3D models with 

others is becoming cheaper and easier. The author believes it is not difficult for nautical 

archaeologists to share their 1:1 scale constrained photogrammetric models and 3D 

reconstruction models using 3D model sharing software with downloadable settings. 

This should be done with peer-review journal websites acting as data archives or through 

scholar’s personal accounts. An important point is that these 3D models should be 

accessible to other scholars so that they can test what was written in the journal articles. 

This could raise the standards of nautical archaeology to same level as that of the natural 

sciences; as a result, the body of knowledge of maritime history could be much richer.  

In short, the author believes that Computer Vision Photogrammetry can also 

break the paradigm of nautical archaeology as a social science by sharing 1:1 scale 

constrained photogrammetric data with its peer-reviewed journals. The author strongly 

recommends that publishers of peer-reviewed journals have 3D model sharing services 

or accounts in order to share archaeologists’ results and data with other scholars so that 

published archaeological research can be tested and refined. The author may be too 

naïve about this notion, and there are many processes and obstacles that we have to 

overcome. But nautical archaeologists are already creating 1:1 scale constrained 
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shipwreck site models, thus, this is a good time to start thinking about next step of 

scholarly researches and publications of nautical archaeology. 
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CHAPTER VI 

CONCLUSION 

 

Conclusions 

The author has discussed the proposed methodology for recording and analyzing 

shipwreck sites in four different sections: data acquisition, data processing, data analysis, 

and sharing knowledge (public outreach and publication). The important point is that this 

methodology is very flexible and still developing along with advances in technology; the 

discussed methodology can be fitted to any type of shipwreck as long as the water 

visibility allows archaeologists to capture fairly clear images. Technology, even 

PhotoScan, can be replaced by more advanced software when it appears. In other words, 

archaeologists will have to modify this methodology to make it suit the needs of their 

projects. This methodology is a philosophy and idea rather than a completed guideline. 

The author strongly believes that the philosophy behind this methodology can change 

the standard of traditional underwater excavations in nautical archaeology. To note one 

more time, the primary idea behind this methodology is to create a 1:1 scale constrained 

accurate replication of a shipwreck site in digital format and to extract archaeological 

information from the digital data in order to proceed with conventional archaeological 

research. This proposed methodology allows archaeologists to skip time-consuming 

underwater measuring; what is more, it can provide more accurate data. This 

methodology can shorten ten years of excavation and recording to two years. This means 

that nautical archaeologists’ field projects can be conducted much more quickly and 
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inexpensively. Consequently, with the same amount of budget and time, archaeologists 

can conduct more projects on underwater cultural heritage. Before closing this 

dissertation, the author would like to note a few more uses of this proposed 

methodology. 

 

Digital in situ Preservation 

One of the great benefits of this proposed methodology is that it produces 1:1 

scale constrained photogrammetric models of shipwreck sites, or real scale replication of 

underwater cultural heritage locations, in digital format. In 2001, the UNESCO 

Convention for Underwater Cultural Heritage was enacted. After this, underwater 

archaeology community recognized the importance of in situ preservation and became 

dedicated to promoting it. The UNESCO 2001 convention promotes protection for 

underwater cultural heritage sites; however, in situ preservation is not a perfect solution 

in terms of protection. Archaeologists and governments must anticipate unexpected 

factors of destruction. Taliban, ISIS, and other extreme activists have destroyed cultural 

heritage and museum displays in Syria and Iraq. Natural disasters, such as earthquakes, 

tsunamis, and volcanic activity have unexpectedly destroyed cultural heritage sites. For 

underwater cultural heritage sites, the activities of treasure hunters and net-dragging 

trawlers are always a major threat. Consequently, we must consider some type of safety 

net strategy along with in situ preservation. The author strongly believes that Computer 

Vision Photogrammetry is possibly the best solution. If archaeologists can succeed in 

creating 1:1 scale constrained photogrammetric models of cultural heritage sites, the 
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dimensions and textures of the cultural heritage sites can be recorded and remain as long 

as the data survives. Moreover, digital in situ preservation can preserve cultural heritage 

in its current condition; therefore, it can be used for monitoring purpose as the author 

discussed in Chapter IV. The idea of digital in situ preservation is not meant to replace 

the strategy of in situ preservation. Digital in situ preservation should be used as a safety 

net for when in situ preservation fails. As long as we have the data provided by 3D 

models and the textures of cultural heritage sites, we can create 1:1 real scale restoration 

or replication when destruction occurs in the future. Henceforth, the author strongly 

recommends that digital in situ preservation be used to protect our cultural heritage, 

including shipwreck sites. 

 

Computer Vision Photogrammetry as a Tool against Treasure Hunters 

One of the major threats to nautical archaeology is the activity of treasure 

hunters. In addition to selling artifacts for money, treasure hunters declare themselves to 

be archaeologists or explorers and proceed with excavation and salvaging activities 

without proper recording of shipwreck sites. This is a destruction of our common human 

heritage, and our history can be lost forever. Because treasure hunters declare their 

activities to be genuine archaeological research, they can receive permission from local 

governments to proceed with their activities.  

For that reason, the author believes that Computer Vision Photogrammetry can 

be a strong tool to be used in the fight against their looting activities. Once nautical 

archaeologists produce 1:1 scale constrained photogrammetric models of shipwreck 
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sites, archaeologists can rightfully claim that most of the archaeological data can be 

acquired from the photogrammetric models. By publishing 3D models and submitting 

3D data to local governments, archaeologists may be able to eliminate the justification 

given by treasure hunters that they must visit and destroy the shipwreck for their 

research. Moreover, if the proposed methodology becomes a new standard for 

underwater surveys and excavations, recording shipwreck sites before and after 

excavations could become the standard of underwater research. In that case, all activity 

on underwater cultural heritage becomes more transparent. Then, looting activities and 

destruction of shipwreck sites can be disclosed easily. In short, archaeological 

excavation using Computer Vision Photogrammetry, including the proposed 

methodology, can be a strong deterrent against treasure hunters. For that reason, the 

author strongly promotes the use of Computer Vision Photogrammetry and the proposed 

methodology as a new standard for nautical archaeology in order to protect underwater 

shipwreck sites from treasure hunters. 

 

Legacy Photogrammetry  

The author and his colleagues promote another aspect of Computer Vision 

Photogrammetry called Legacy Photogrammetry. Nautical archaeologists have been 

using photography for their underwater excavations since the 1960s. Many of the photos 

that were taken were used to create photomosaics of the shipwreck sites. Fortunately, 

some of these photos can be used for Computer Vision Photogrammetry. One of the 

author’s colleagues, Thomas Van Damme, calls this application Legacy 
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Photogrammetry, using old data to create 3D models (Van Damme, 2015). Based on the 

author’s experience, by choosing properly scanned photos and applying the proper 

masks and markers, Legacy Photogrammetry can be surprisingly successful (Fig. 6-1). 

In addition, many former excavations and research endeavors left good data regarding 

the dimensions and measurements of shipwrecks. Therefore, today’s archaeologists can 

apply these measurements to constrain photogrammetric models to 1:1 scale. If 3D 

models are successfully created and constrained to a 1:1 scale, these models become 

diagnostic and can be used for further archaeological research (Fig. 6-2). There are many 

photos from former excavations and research endeavors being stored untouched. The 

author and his colleagues want to promote the possibility of using Legacy 

Photogrammetry to revisit and extract more data from previous studies. 

 

 

 
Figure 6-1. Legacy Photogrammetry of the Batavia shipwreck. The photogrammetric model was 

reconstructed based on 19 selected site photos. (Image: Yamafune) 
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Figure 6-2. Section profile extraction of Batavia shipwreck. 1:1 scale constrained models can be diagnostic 

even though photos were taken decades ago. More scholarly researches and archaeological data of Batavia 

shipwreck can be seen in Van Duivenvoorde and Green’s publication (2015). (Image: Yamafune) 

 

 

To Conclude: Leaving Data for Future Generations 

The author believes that archaeology, the study of human history, has two main 

responsibilities: the first responsibility is to interpret the human past correctly, and the 

second responsibility is to protect the memories of humanity. The first responsibility is 

fulfilled by archaeological research. In this dissertation, the author has discussed a 

method to assist with this. Nevertheless, the author also wants to remark on the 

importance of the second responsibility of archaeology. Cultural heritage and all 

archaeological remains are the memories of humanity, like old pictures of a person. 

Without understanding and keeping the memory of the past, people cannot appreciate 

their life in the present or future.  However, understanding the meaning of the past is a 

dynamic process: today’s archaeologists can goas far as the data allows, but the future 
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archaeologists will inevitably have more data to refine our understanding of the past. 

Often we cannot fully comprehend the significance of an archaeological site or its 

artifacts at the time of its excavation and initial publication. As today’s archaeologists, it 

is our important responsibility to protect and leave these memories intact for future 

generations. These memories can be in the form of cultural heritage. Fortunately, 

technologies are developing quickly; the cost of 3D printers is dropping and printing 

capacity is rising and engineers and scientists are developing applications of 3D 

holography and augmented reality. The application of 3D data is developing so rapidly 

that nobody can predict their capability in the future. Thus, the author believes that 

leaving 3D data to future generations is the one of our top priorities as archaeologists. As 

today’s archaeologists can create 3D models from photos (which archaeologists in 1960s 

might not have imagined), future archaeologists will likely create something that we 

cannot even imagine today. 

To conclude, the proposed methodology satisfies two major responsibilities of 

archaeologists: understanding the past correctly and leaving memories and data for 

future generations. This methodology can provide accurate archaeological data to 

archaeologists to help understand shipwreck sites; meanwhile, it produces 1:1 scale 

constrained photogrammetric models with high-resolution textures that provide detailed 

information. Additionally, the data acquisition depends primarily on photo-shooting that 

can be accomplished in a tremendously shorter time than conventional data acquisition 

methods, such as manual measuring. Once 1:1 scale constrained models are produced, 

archaeologists can extract accurate archaeological data from the model, and research can 
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proceed to data processing and data analysis methods that do not require revisiting 

underwater archaeological sites. If this methodology becomes a new standard and is 

taught to young students of nautical archaeology, the author believes that the standards 

of underwater surveys and excavations can be raised. And this possible new standard 

could eventually lead to protection of underwater cultural heritage. Yet, the author must 

note one more time, this proposed methodology is just a tool to assist in the conventional 

research tasks performed by nautical archaeologist; to use this methodology correctly, 

basic knowledge of the history of shipbuilding and an understanding of conventional 

reconstruction methods of shipwreck sites is a prerequisite.  

The author hopes this dissertation will be used as a guideline for underwater 

excavations and research so that our grandchildren’s generation can enjoy the history of 

shipwrecks being excavated today.     
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